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About this guide

This guide provides service and maintenance information.

IMPORTANT: Removal and replacement procedures are now available in videos on the HP website.

Go to the HP Customer Self Repair Services Media Library at http://www.hp.com/go/sml.

Guide topics

Hardware overview on page 1

System management on page 11

Component replacement information and guidelines on page 36

Diagnostics and troubleshooting on page 46

Configuring password security and resetting CMOS on page 71

Linux technical notes on page 75

Configuring RAID devices on page 78

System board designators on page 83

NOTE: View the HP Z1 G2 Workstation User Guide at http://www.hp.com/support/workstation_manuals.
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1 Hardware overview 

The HP Z1 G2 Workstation is offered in both a touch and a non-touch model. The touch model has a glossy 
glass front, and the non-touch model has a matte surface, surrounded by a plastic bezel.

HP continually improves and changes product parts. For complete and current information on supported parts 
for your computer, go to http://partsurfer.hp.com, select your country or region, and then follow the on-
screen instructions.

This chapter presents an overview of workstation hardware components.

Topics

Front and bottom components on page 2

Side components on page 3

Rear components on page 4

Chassis components on page 5

System board components on page 6

System board architecture on page 7

Workstation specifications on page 8

1
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Front and bottom components 

1 Camera angle adjustment dial 5 Serial number pull-out card

2 Camera 6 Speakers

3 Left and right digital microphones 7 Stand

4 Display panel 8 Chassis latches (bottom view)

2 Chapter 1   Hardware overview
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Side components 

1 Power button 5 USB 3.0 port

2 Hard drive activity light 6 USB 3.0 with battery charging port

3  
Slimline slot-load optical drive (or 
optional ThunderboltTM 2 module)

7 Headset jack

4  Memory card reader 8 Microphone jack

Side components 3
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Rear components 

1  Handle 6  Power cord connector

2 Subwoofer jack(orange) 7 USB 2.0 connectors (4)

3 Audio line-out jack (green) 8 Optical S/PDIF audio output

4 Audio line-in jack (blue) 9 RJ-45 network connector

5  DisplayPort 1.1a connector 10  Security cable slot

4 Chapter 1   Hardware overview
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Chassis components 

1 Chassis and display assembly 7 Memory modules (DIMMs) 13 Graphics filler block (installed if 
graphics card assembly is not 
ordered)

2 Stand 8 Slot-load optical drive 14 Rear I/O board

3 Power supply 9 3.5” hard drive carrier 15 Wireless keyboard/mouse USB 
receiver

4 Graphics card assembly 10 System board 16 Memory fan

5 Mini-PCIe or mSATA card 11 Side I/O board 17 Optional Thunderbolt 2 module 
(installed in slot-load optical drive 
bay)

6 Processor (CPU) heatsink 12 Speakers 18 Optional 2.5” hard drive carrier

Chassis components 5
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System board components 
The following figure and table describe the system board component layout.

I/O Cooling Misc

1 Internal USB 11 CPU fan 24 Display

2 Rear DP/LAN 12 Memory fan 25 Hood sensor

3 Rear USB 13 MXM fan 26 LED backlight

4 Rear audio  Power 27 Speakers

5 Side I/O 14 Battery 28 Webcam/Mic

6 Touch controller header 15 Main power 29 Thunderbolt 2 module PCIe

 SATA 16 Optical drive power 30 Thunderbolt 2 module DisplayPort

7 Hard drive SATA (6 Gb/s) 17 User panel I/O header 31 Thunderbolt 2 module power

8 Optical drive SATA (6 Gb/s) 18 HDD power connector 32 Side I/O memory card reader

 PCI/PCIe  Service 33 Side I/O USB 3.0

9 Mini PCIe/mSATA (2) 19 Clear CMOS 34 Side I/O USB 3.0 battery charging

10 MXM graphics 20 Crisis Recovery jumper 35 Side I/O audio (headset)

  21 ME/AMT flash override jumper 36 Side I/O audio (mic)

  22 Boot block enable   

  23 Password jumper   

6 Chapter 1   Hardware overview
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System board architecture 
The following figure shows the system board block diagram.

System board architecture 7
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Workstation specifications 

Physical characteristics and technical specifications 

HP Z1 G2 Workstation

Weight 

With stand (non touch)

With stand (touch)

19.2 kg (42.3 lbs)

21.0 kg (46.3 lbs)

Without stand (non touch)

Without stand (touch)

13.3 kg (29.3 lbs)

15.1 kg (33.3 lbs)

Stand only 5.9 kg (13.0 lbs)

Dimensions 

Upright, including stand Height: 533.4 mm (21.0 in)

Width: 660.4 mm (26.0 in)

Depth: 419.1 mm (16.5 in)

Unit only Height: 457.2 mm (18.0 in)

Width: 660.4 mm (26.0 in)

Depth: 81.3 mm (3.2 in)

Processor technology 

Intel® Series C226 chipset with:

● Support for the Intel® Xeon® Processor E3 v3 Family or 4th generation Intel® Core™ 
processors up to 95W

● Integrated 2-channel memory controller

● Microarchitecture improvements

● Integrated graphics (some models)

● Advanced Vector Extensions (AVX) to increase floating point performance

● Intel DMI2 interface connecting the processor to the I/O controller

Power supply 
● 400 W, 90% efficient, compatible with ENERGY STAR® Version 6.0 requirements

● Supports European Union ERP Lot 6 tier 2 power limit of less than 0.5 W in off mode

Memory technology

● Dual inline memory modules (DIMMs) based on DDR3 1866 MHz technology

● Supports error checking and correcting (ECC) and non-ECC DIMMs

● Two direct-attach memory channels that enable low-latency access and fast data transfer 
for improved performance

● Up to 32 GB system memory (8 GB DIMMs)

● 1866 MHz, 2 GB, 4 GB, or 8 GB ECC unbuffered DIMM

● 1866 MHz, 4 GB non-ECC unbuffered DIMM

NOTE: The processor controls the speed of the memory. If the processor supports only 1600 
MHz memory, the memory will run at 1600 MHz regardless of the speed capability of the DIMMs.

Graphics 

● One MXM graphics card assembly (optional) that has PCIe x16 Gen3 link

NOTE: MXM graphics can simultaneously drive up to 4 displays. For example it can drive 
the internal display and a monitor connected to the external DisplayPort and a monitor 
connected to each port on the optional Thunderbolt 2 module, if installed. Or it can drive 4 
multistream monitors connected to a port on the optional Thunderbolt 2 module, if 
installed; in this case the internal panel will not be active.

8 Chapter 1   Hardware overview
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HP Z1 G2 Workstation

NOTE: The speed of the PCIe x16 link is determined by the processor and the graphics 
card. If the processor or the graphics card only supports PCIe Gen2 speeds, the MXM PCIe 
x16 link will run at Gen2 speeds.

● Supports Intel HD Graphics 4400, 4600, or P4600 (depends on processor type)

NOTE: If an MXM graphics card is installed, Intel HD Graphics is disabled.

NOTE: Intel Core processors provide Intel HD Graphics 4400 or 4600; Intel Xeon processors 
with model designations that end in "---5" provide Intel HD Graphics P4600.

NOTE: Intel HD graphics can drive up to 3 displays simultaneously. For example, it can drive the 
internal display and a monitor attached to the external DisplayPort and a monitor attached to 
the port on the optional Thunderbolt 2 module, if installed. Or it can drive 3 multistream displays 
off the optional Thunderbolt 2 module, if installed; in this case the internal display will not be 
active.

I/O technology 

● RAID configurations for SATA RAID levels 0, 1

● External and internal USB 2.0 ports

● External USB 3.0 ports; the lower port supplies USB battery charging

● HP Low Power State technology enabled

● Supports European Union ERP Lot 6 tier2 power limit of less than 0.5W in off mode

● RJ-45 for LAN

● DisplayPort (output/input)

● Webcam

● Digital microphone array

● Headset and microphone

● Line in and line out

● Subwoofer

● Optical S/PDIF output

● SD 4.0 card reader

● Thunderbolt 2 port(s) if optional Thunderbolt module installed

NOTE: MXM graphics supports 2 Thunderbolt 2 ports; Intel HD graphics supports 1 
Thunderbolt 2 port.

Workstation specifications 9
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Environmental specifications 

Temperature

Operating: 5°C to 35°C (40°F to 95°F)

Nonoperating: -40°C to 60°C (-40°F to 140°F)

NOTE: The ambient upper limit of 35°C is good up to 1524 m (5000 ft) elevation. Derate by 1°C for 
every 305 m (1000 ft) above 1524 m (5000 ft). For example, at 3,048 m (10,000 ft), the upper 
ambient air temperature limit is 30°C.

Humidity
Operating: 8% to 85% relative humidity, non-condensing

Nonoperating: 8% to 90% relative humidity, non-condensing

Altitude
Operating: 0 to 3,048 m (10,000 ft)

Nonoperating: 0 to 9,144 m (30,000 ft)

Shock

Operating: ½-sine: 40g, 2–3 ms (~62 cm/sec)

Nonoperating:

● ½-sine: 160 cm/s, 2–3 ms (~105g)

● square: 422 cm/s, 20g

NOTE: Values represent individual shock events and do not indicate repetitive shock events.

Vibration

Operating random: 0.5g (rms), 5–300 Hz, up to 0.0025 g2/Hz

Non-operating random: 2.0g (rms), 5–500 Hz, up to 0.0150 g2/Hz

NOTE: Values do not indicate continuous vibration.

Location and ventilation

Proper ventilation for the system is important for workstation operation. To be sure that ventilation is 
adequate, do the following:

● Operate the workstation on a sturdy, level surface.

● Provide at least:

◦ 12 cm (4.7 in) clearance at the front, back, top, and bottom of the workstation

◦ 16 cm (6.3 in) clearance on the right side for the optical drive

● Confirm that the ambient air temperature surrounding the workstation falls within the specified limits 
(see Environmental specifications on page 10).

● Never restrict the incoming or outgoing airflow of the workstation by blocking any vents or air intakes.

10 Chapter 1   Hardware overview
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2 System management 

This section describes the tools and utilities that provide system management for the workstation.

Topics

Power management features on page 11

BIOS ROM on page 12

Computer Setup (F10) Utility on page 13

Desktop management on page 23

Power management features

ERP compliance mode

This computer provides ERP compliance mode capability.

When this feature is enabled, the computer shuts down to the lowest possible power state. The computer 
must then be turned on with the power button. One of the effects is that "wake on LAN" is disabled.

When this feature is disabled, the computer shuts down conventionally.

Enabling ERP 
compliance mode

1. Power on or restart the workstation and press F10 during startup to launch the Computer Setup (F10) 
utility.

2. Using the arrow keys, select Power, then Hardware Power Management, and then S5 Maximum Power 
Savings.

3. Select Enable, and then press Enter to accept the change.

4. Select File, and then select Save Change and Exit. Press Enter to accept the change.

5. If using Windows 8 or Windows 8.1, boot to Windows and search in the Start Menu for the setting 
Change what the power buttons do. Uncheck Turn on fast startup (recommended). If the checkbox is 
not available, select Change settings that are currently unavailable at the top of the window.

If using Windows 10, use the taskbar search field to search for Power Options. Select Choose what the 
power button does, then select Turn on fast startup (recommended).

Disabling ERP 
compliance mode

1. Power on or restart the workstation and press F10 during startup to launch the Computer Setup (F10) 
utility.

2. Using the arrow keys, select Power, then Hardware Power Management, and then S5 Maximum Power 
Savings.

3. Select Disable, and then press Enter to accept the change.

4. Select File, and then select Save Change and Exit. Press Enter to accept the change.

5. If using Windows 8 or Windows 8.1, boot to Windows and search in the Start Menu for the setting 
Change what the power buttons do. Check Turn on fast startup (recommended). If the check box is 
not available, select Change settings that are currently unavailable at the top of the window.

If using Windows 10, use the taskbar search field to search for Power Options. Select Choose what the 
power button does, then select Turn on fast startup (recommended).

Power management features 11
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Hyper-Threading Technology (HTT)

This computer supports HTT, an Intel-proprietary technology that improves processor performance through 
parallelization of computations (doing multiple tasks at once).

The operating system treats an HTT-enabled processor as two virtual processors and shares the workload 
between them when possible. This feature requires that the operating system support multiple processors 
and be specifically optimized for HTT.

Use the Computer Setup (F10) Utility to enable HTT.

Go to http://www.hp.com/go/quickspecs to determine if your CPU supports HTT.

SATA Power Management

SATA Power Management enables or disables SATA bus and/or device power management.

Intel Turbo Boost Technology

The HP Z Workstation series supports Intel® Turbo Boost Technology.

This feature enables the CPU to run at frequencies above the normal frequency. When all CPU cores are not 
necessary for the workload, inactive cores are turned off and power is diverted to the active cores to increase 
their performance.

Turbo Boost is enabled and disabled with the Computer Setup (F10) Utility.

Go to http://www.hp.com/go/quickspecs to determine if your CPU supports Turbo Boost.

BIOS ROM
The BIOS ROM is a collection of machine language applications stored as firmware in ROM. It includes 
functions such as Power-On Self-Test (POST), PCI device initialization, Plug and Play support, power 
management, and Computer Setup (F10) Utility.

Go to http://www.hp.com/go/quickspecs to review the latest BIOS ROM specifications.

12 Chapter 2   System management
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Computer Setup (F10) Utility

Topics

Computer Setup (F10) Utility functions on page 13

Accessing Computer Setup (F10) Utility on page 14

Computer Setup (F10) Utility menu on page 15

Computer Setup (F10) Utility functions

This section presents the Computer Setup (F10) Utility functions. In most cases, OS-specific information is 
described for a Windows-based computer, however much of this information applies to all operating systems. 
Occasional notes about non-Windows operating systems are included.

Computer Setup (F10) Utility enables you to perform the following tasks:

● Update BIOS using a USB device.

● Change factory default settings and set or change the workstation configuration, which might be 
necessary when you add or remove hardware.

● Determine whether all devices installed on the workstation are recognized by the system and are 
functioning.

● Determine information about the operating environment of the workstation.

● Solve system configuration errors that are detected but not resolved during the Power-On Self-Test 
(POST).

● Establish and manage passwords and other security features.

● Establish and manage energy-saving time-outs.

● Set the workstation date and time, and modify or restore factory default settings.

● Set, view, change, or verify the workstation configuration, including settings for CPU, graphics, memory, 
audio, storage, communications, and input devices.

● Modify the boot order of installed mass storage devices such as SATA drives, optical drives, and network 
drives.

● Enable or disable Network Server Mode. This mode enables the workstation to start the operating 
system when the power-on password is enabled, with or without a keyboard or mouse attached. When 
the keyboard and mouse are attached to the workstation, they remain locked until the power-on 
password is entered.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test (POST) 
messages. Post Messages Disabled suppresses most POST messages, such as memory count, product 
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless of the 
mode selected. To manually switch to Post Messages Enabled during POST, press any key (except F1 
through F12).

● Specify an Ownership Tag, which is displayed on the screen when the workstation is started or restarted.

● Specify the Asset Tag or property identification number assigned to this workstation.

● Enable power-on password prompts during system restarts (warm-starts) and when the computer is 
started.

Computer Setup (F10) Utility 13
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● Hide or show the integrated I/O functionality, including serial, USB, or parallel ports, audio, or embedded 
NIC. Hidden devices are inaccessible, which increases system security.

● Enable or disable removable media boot ability.

● Enable or disable removable media write ability (if supported by hardware).

● Replicate the workstation setup by saving system configuration information to removable storage or 
restoring it.

Accessing Computer Setup (F10) Utility

Accessing Computer Setup (F10) Utility requires a keyboard. To access Computer Setup (F10) Utility:

1. Turn on or restart the workstation.

2. When the display is active and Press the Esc key for Startup Menu appears at the bottom of the screen, 
press F10 or Esc.

If you do not press F10 or Esc at the appropriate time, try again. Turn the workstation off, then on, and 
press F10 again to access the utility. You can also press Ctrl + Alt + Delete before starting if you do not 
press F10 before the message disappears.

3. Select a language from the list, and press the Enter key.

In the Computer Setup (F10) Utility menu, five headings are displayed: File, Storage, Security, Power, 
and Advanced.

NOTE: The option for selecting the language is available on first boot only. To reset the selection, press 
Esc during POST and from the Startup menu, select Change Language to switch between languages.

4. Use the left and right arrow keys to select the appropriate heading, use the up and down arrow keys to 
select an option, and then press Enter.

5. Choose from the following:

● To apply and save changes, select File and then select Save Changes and Exit. Press Enter to 
accept the changes.

● To remove changes you have made, select Ignore Changes and Exit, and then press Enter to 
acknowledge the cancellation.

● To restore factory settings, select File, select Default Setup, and then select Restore Factory 
Settings as Default. Press Enter to accept the changes, and then select Apply Defaults and Exit.

CAUTION: Do not turn off the workstation while saving Computer Setup (F10) Utility changes, because the 
Complementary Metal-Oxide Semiconductor (CMOS) nonvolatile storage could become corrupted. Turn off 
after you exit the F10 Setup screen.

14 Chapter 2   System management

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


Computer Setup (F10) Utility menu

The following table describes the functions available in the Computer Setup (F10) Utility menu.

NOTE: With new BIOS releases, the following content is subject to change, so the menu might be different 
than shown.

Heading Option Description

File System 
Information

Displays the following information:

● Product Name

● Manufacturer

● SKU Number

● Processor Type

● Processor Speed

● Processor Stepping

● Memory Size

◦ Channel A

◦ Channel B

● Integrated MAC

● Chassis serial number

● Asset Tracking Number

● System Board ID

● System Board CT Number

● BIOS Version & Date

● ME Firmware Version

 About Displays system BIOS copyright information.

 Set Time and 
Date

Enables you to set system time and date.

 Flash System 
ROM

Enables you to upgrade the BIOS from a ROM image on a CD or USB or hard drive or network.

 Replicated Setup Provides these options:

● Save to Removable Storage Device—Saves the workstation configuration, including CMOS, in the 
cpqsetup.txt file. This file can be saved to a USB removable storage device.

● Restore from Removable Storage Device—Restores the workstation configuration from a USB 
removable storage device.

 Default Setup Provides these options:

● Save Current Settings as Default—Saves the current settings as default settings for the next 
operation.

● Restore Factory Settings as Default—Restores the factory settings as the default settings for the 
next operation.

 Apply Defaults 
and Exit

Restores the default settings defined in Default Setup.
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Heading Option Description

 Ignore Changes 
and Exit

Exits workstation setup without applying or saving changes.

 Save Changes 
and Exit

Saves changes to system configuration and exits the workstation setup.

Storage Device 
Configuration

Lists installed storage devices and provides options for obtaining specific information about each device:

To see additional information about a device, use the Up and Down arrow keys to see a device and press 
Enter to show additional details about the device if available.

Hard Disk

● SATA0 <DRIVE CAPACITY>, <DRIVE MFG and/or MODEL> (If installed)

● SATA1 <DRIVE CAPACITY>, <DRIVE MFG and/or MODEL> (If installed)

● SATA5 <DRIVE CAPACITY>, <mSATA DRIVE MFG and/or MODEL> (If mSATA installed in SLOT2)

CD-ROM

● SATA2 <MFG MODEL> (If installed)

 Storage Options Provides these options:

● SATA Emulation—Sets the SATA emulation mode with the following options:

◦ RAID —RAID OPROM executes. This emulation mode is the default and offers the best 
performance and most functionality.

◦ IDE—Legacy emulation mode

◦ AHCI—Advanced host controller interface emulation

● Removable Media Boot—Enables and disables the ability to start the workstation from removable 
media.

 Boot Order Enables you to configure the boot order by physically reordering the menu entries. The following is the 
default boot order presented in the menu:

● UEFI Boot Sources

◦ OS-specific Boot Manager

◦ ATAPI CD/DVD Drive

◦ USB Floppy/CD

◦ USB Hard Drive

◦ Hard Drive (may only appear if the device has an EFI boot file on it)

● Legacy Boot Sources

◦ ATAPI CD/DVD Drive

◦ USB Floppy/CD

◦ Hard Drive

— USB Hard Drive

— Hard Drive Name

◦ Network Controller (This option is available only if the workstation is connected to a 
network.)

Use the arrow keys to move the cursor to a listed device, and then perform one of the following actions:

● Press Enter to select or deselect the device.
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Heading Option Description

● Use the arrow keys to move a selected device up or down in the boot order. Press F10 to accept the 
new boot order.

● For a selected device, press F5 to enable or disable it as a bootable device.

MS-DOS drive lettering assignments might not apply after an operating system other than MS-DOS has 
started.

Boot devices can be disabled in the boot order process. These order changes are stored in the physical 
ROM when the F10 Setup changes are confirmed. Select File, select Save Changes, and then select Exit.

You can temporarily override the boot order. To start one time from a device other than the default 
device specified in Boot Order, restart the workstation and press F9 when the F9=Boot Menu message 
appears on the screen. After POST completes, a list of bootable devices is displayed. Use the arrow keys 
to select the preferred bootable device, and then press Enter. The workstation then starts from the 
selected non-default device for this one time.

Security Setup Password Enables you to set and enable a setup password for the administrator.

If you create a setup password, you must use it to change workstation setup options, to flash the ROM, 
and to make changes to certain Plug and Play settings under Windows.

 Power-On 
Password

Enables you to set and enable the power-on password.

 Password 
Options

This option becomes available when you create a setup and/or power-on password. It provides these 
options:

● Setup Browse Mode—Enables read-only functionality for password info.

● Password Prompt on F9, F11 & F12—Enables a password prompt on a warm boot.

● Network Server Mode—Enables network server mode.

● Stringent Password—(Disable/Enable) Creates a password that cannot be reset by the password 
jumper.

 Device Security Makes the following devices available or hidden to the workstation:

● Embedded Security Device

● Card Reader Controller

● Internal Webcam Device

● Touch Controller

● System Audio

● Network Controller

● SATA0

● SATA1

● SATA2

● Thunderbolt Security Level (These options are available only when the Thunderbolt 2 module is in 
the system.)

◦ Legacy Mode (This option allows all devices to connect without user intervention.)

◦ Unique ID (default) (Device connection is managed by the Thunderbolt Service running on the 
host system. The Thunderbolt Service is currently available only on Windows. Upon first 
device connection, the Thunderbolt Service prompts you to connect, and you can choose 
from Do Not Connect, One Time Connect, or Always Connect. Choosing Always Connect for 
one device allows any device of the same type to connect to the system. For example, 
selecting Always Connect for one LaCie Little Big Disk allows any LaCie Little Big Disk to 
connect to the system.)

Computer Setup (F10) Utility 17

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


Heading Option Description

◦ One time saved Key (Applies to Falcon Ridge devices only, allows Thunderbolt host controller 
to differentiate between many of the same type of device.)

◦ DP++ only (This option allows only monitor connections and does not allow data traffic.)

For each device (except Embedded Security Device), Device Available is the default setting and allows 
the operating system to access the device. Device Hidden makes the device unavailable; it is disabled by 
the BIOS and cannot be enabled by the operating system.

NOTE: An entry for enabling DriveLock will only appear in the setup menu if the workstation has at 
least one enabled hard drive that supports it.

 USB Security Set workstation USB ports to Enabled/Disabled:

● Side USB Ports

◦ USB3 Port 1

◦ USB3 Port 2

● Rear USB Ports

◦ USB Port 1

◦ USB Port 2

◦ USB Port 3

◦ USB Port 4

 Slot Security Lets you enable or disable any mini PCIe/mSATA slot.

 Network Boot Enables or disables the ability to boot to the network using the F12 key or the boot order.

 System IDs Provides these options:

● Enter Asset Tag—A 16-byte string identifying the workstation.

● Enter Ownership Tag—An 80-byte string identifying ownership of the workstation. This tag 
appears on the screen during POST.

● Enter UUID (Universal Unique Identifier)—Can only be updated if the current chassis serial number 
is invalid. (These ID numbers are normally set in the factory and are used to uniquely identify the 
workstation.)

● Keyboard Layout—Enables you to set the keyboard locale for System ID entry.

 Master Boot 
Record Security

Enable or Disable—This option is for advanced users. When Master Boot Record (MBR) Security is 
enabled, the BIOS prevents any changes being made to the MBR of the current bootable disk while in 
MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot 
prevent changes that may occur while the operating system is running.

 System Security Provides these options:

● Data Execution Prevention—Enables or disables Data Execution Prevention mode in the CPUs. This 
mode prohibits code from running in pages that were set up as data pages, and prevents attacks 
such as buffer overflows. Operating system support is required for this feature.

● Virtualization Technology (VTx)—Enables or disables Intel Virtualization Technology to increase 
workstation performance. (Only visible on supported CPUs)

● Virtualization Technology Directed I/O (VTd)—(Enabled or Disabled) Controls the underlying 
processor and chipset features needed to support a virtual appliance.

● Trusted Execution Technology—(Disabled/Enabled) Turns Intel TXT feature on or off.

● Embedded Security Device—This option becomes available if Embedded Device is set to Available 
under Device Security.
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NOTE: Embedded Security Device must be set to Device Available in the Device Security menu, 
and you must create a Setup Password, in order to configure the Embedded Security Device.

Embedded Security Device—(Hidden or Available) turns the Trusted Platform Mechanism (TPM) on 
and off. Device Hidden is the default. If this option is made available, the following options become 
available:

◦ Reset to factory settings

◦ Measure boot variables/devices to PCR1

For more information on TPM go to http://technet.microsoft.com/en-us/library/cc749022(v=ws.
10).aspx.

To enable the Embedded Security Device and to access any security features associated with the 
device, you must enter a setup password.

Setting a device to Available enables the operating system to access the device. Hidden makes the 
device unavailable. It is disabled by the BIOS and cannot be enabled by the operating system.

CAUTION: Choosing Reset to Factory Settings may result in significant data loss. The embedded 
security device is a critical component of many security schemes. Erasing the security keys 
prevents access to data protected by the Embedded Security Device.

● OS Management of Embedded Security Device—Enables or disables the ability of the operating 
system to control the TPM device, including turning it on and off, initializing it, and resetting it.

◦ Reset of Embedded Security Device through OS—Enables or disables the ability of the 
operating system to reset the TPM. Available only when OS Management of Embedded 
Security Device is enabled.

◦ No PPI provisioning

◦ Allow PPI policy to be changed by OS

 DriveLock 
Security

Lets you assign or modify a master password or user password for hard drives. When enabled, this 
feature prompts the user to provide one of the DriveLock passwords during POST. If the user does not 
successfully enter one of the passwords, the hard drive remains inaccessible until one of the passwords 
is successfully entered during a subsequent cold-boot sequence.

NOTE: This selection appears only when the system includes at least one drive that supports the 
DriveLock feature.

 Secure Boot 
Configuration

● Legacy Support—(Enable/Disable)

● Secure Boot—(Enable/Disable)

● Key Management

◦ Clear Secure Boot Keys—(Clear/Don't Clear)

◦ Key Ownership—(HP Keys/Custom Keys)

● Fast Boot—(Enable/Disable)

For more information on secure boot management go to http://h10025.www1.hp.com/ewfrf/wc/
document?docname=c03653226&cc=us&dlc=en&lc=en.

Power OS Power 
Management

Enables or disables:

● Runtime Power Management—(Enable or Disable)

● Idle Power Savings—Extended (default) or Normal; extended mode reduces processor power 
consumption when the CPU is idle

● Unique Sleep State Blink Rates—(Enable or Disable)

 Hardware Power 
Management

Enables or disables:

● SATA Power Management
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● S5 Maximum Power Savings

 Thermal Enables you to set the rate of the system fan when the CPU is in idle (Fan Idle Mode).

Advanced Power-On 
Options

Enables you to set the following:

● POST Messages—Enables or disables the splash screen during POST.

● Press the Esc key for Startup Menu

● Option ROM Prompt—(Enable or Disable) Enabling this feature causes the workstation to display a 
message before loading options ROMs.

● After Power Loss (On, Off, Previous State)—”On” means the system will power on again after 
power is restored. “Off” means it will remain shut down after power is restored. “Previous State” 
directs the previous state to be the default after power is restored.

● POST Delay (in seconds)—Adds a specified delay (5, 10, 15, 20, None) to the POST process. This 
delay is sometimes needed for hard drives on some expansion cards that spin up slowly (so slowly 
that they are not ready to start by the time POST is finished). The POST delay also gives you time to 
select F10 to enter Computer Setup (F10) Utility or other startup functions (e.g., F9 Boot Menu or 
F2 Diagnostics)..

● Remote Wakeup Boot Source—Enables you to set the remote wakeup boot source as:

◦ Local Hard Drive

◦ Remote Server

● Factory Recovery Boot Support—(Disabled/Enabled)

● Bypass F1 Prompt on Configuration Changes

● POST Memory Manager Runtime Allocation—(Disabled/Enabled) Enabling this forces legacy POST 
Memory Manager (PMM) to use runtime memory for allocation. This prevents Hibernation (S4) 
issues with some UEFI Windows installations.

 BIOS Power-On Enables you to disable or specify a weekday and time for BIOS power-on. If this feature is enabled, the 
system will self-boot at the appointed day and time.

 Onboard Devices Enables you to select the Legacy Device’s IRQ, DMA, and I/O Range. The settings may not take effect for 
all operating systems. To hide a device from the OS, see Security/Device Security.

Bus Options Configures graphics cards per workstation slots.

● PCI SERR# Generation—(Enabled/Disabled) Controls PCI SERR# generation for ill-behaved PCI add-
in cards (that can generate SERR# spuriously)

 Device Options Enables you to set the following device options:

● Turbo Mode—(Enabled/Disabled) Allows Intel Processors to run at frequencies above the normal 
frequency. (Only visible on supported CPUs)

● S5 Wake on LAN—(Enabled/Disabled) Allows unit to be turned on over the network.

● Num Lock State at Power-On—(On or Off)

● IGD (Integrated Graphic Device) Memory—Displayed when Integrated Video is Enabled. Sets the 
maximum amount of system memory that can be allowed as graphics memory (32M, 64M 
(default), 128M, 256M, 512M, 1024M).

● Internal speaker—(Enable or Disable)

● USB EHCI Port Debug—(Enable or Disable)

● Multi-Processor (Activates a single core.)—(Enable or Disable)

● Hyperthreading—(Enable or Disable) (Only visible on supported CPUs)

 Slot Settings Enables you to set the following options for the Mini PCIe/mSATA slots:
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● Slot 1 Option ROM Download—(Enabled/Disabled)

● Slot 2 Option ROM Download—(Enabled/Disabled)

 Management 
Operations

Lets you set the following AMT (Intel Active Management Technology) configuration options:

● AMT—(Enabled/Disabled) Allows for remote discovery, repair and protection of networked 
workstations. Enabling the AMT function also enables the Network Controller (required for AMT to 
function correctly).

● Unconfigure AMT/ME—(Disabled/Enabled) Restores AMT/ME defaults. When you save and exit 
after enabling this option, you will be prompted to complete the process upon restart. A Setup 
Password (even if one is set) does not need to be entered to complete the process.

NOTE: Information about Intel AMT can be found at www.intel.com.

● Hide Un-Configure ME Confirmation Prompt—(Disabled/Enabled)

● WatchDog Timer—(Enabled/Disabled) OS and BIOS WatchDog Timers can be set independently (in 
minutes):

◦ OS WatchDog Timer—Sets the OS WatchDog Timer

◦ BIOS WatchDog Timer—Sets the BIOS WatchDog Timer

 Option ROM 
Launch Policy

● PXE Option ROMS—(Legacy, UEFI Only, Do Not Launch)

● Storage Option ROMS—(Legacy, UEFI Only, Do Not Launch)

● Video Option ROMS—(Legacy, UEFI Only)

 Connected BIOS ● Connected BIOS—(Enable/Disable)

● Use Proxy—(Enable/Disable)

For more information about Connected BIOS, go to http://h20565.www2.hp.com/portal/site/hpsc/
template.PAGE/action.process/public/psi/mostViewedDisplay/?
sp4ts.oid=5403903&javax.portlet.action=true&spf_p.tpst=psiContentDisplay&javax.portlet.begCacheT
ok=com.vignette.cachetoken&spf_p.prp_psiContentDisplay=wsrp-interactionState%3DdocId
%253Demr_na-c04119260%257CdocLocale
%253Den_US&javax.portlet.endCacheTok=com.vignette.cachetoken.

 Update BIOS via 
Network

● Update BIOS via Network—(Enable/Disable)

● Update Source—(HP, Custom)

● Update Address (Only appears if Custom is selected in Update Source)

● Automatic BIOS Update Setting—(Enable/Disable)

For more information about Updae BIOS via Network, go to http://h20565.www2.hp.com/portal/site/
hpsc/template.PAGE/action.process/public/psi/mostViewedDisplay/?
sp4ts.oid=5403903&javax.portlet.action=true&spf_p.tpst=psiContentDisplay&javax.portlet.begCacheT
ok=com.vignette.cachetoken&spf_p.prp_psiContentDisplay=wsrp-interactionState%3DdocId
%253Demr_na-c04119260%257CdocLocale
%253Den_US&javax.portlet.endCacheTok=com.vignette.cachetoken.

 Intel (R) Ethernet 
Connection I217–
LM — [MAC 
address]

● PORT CONFIGURATION MENU

◦ NIC Configuration

● Link Speed—(Auto Negotiated, 10 Mbps Half, 10 Mbps Full, 100 Mbps Half, 100 Mbps 
Full))

● Wake On LAN—(Enable/Disable)

◦ Blink LEDs

● PORT CONFIGURATION INFORMATION
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◦ UEFI Driver

◦ Adapter PBA

◦ Chip Type

◦ PCI Device ID

◦ Bus:Device:Function

◦ Link Status

◦ MAC Address
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Desktop management
This section summarizes capabilities, features, and key components of computer management.

Topics

Initial computer configuration and deployment on page 24

Installing a remote system on page 24

Copying a setup configuration to another computer on page 24

Updating and managing software on page 25

LANDesk Software on page 25

HP Driver Pack on page 25

HP SoftPaq Download Manager on page 25

HP System Software Manager on page 26

ROM Flash on page 26

FailSafe Boot Block on page 26

Workstation security on page 27

Fault notification and recovery on page 34

Dual-state power button on page 34

NOTE: Support for specific features described in this guide can vary by model and software version.
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Initial computer configuration and deployment

The computer includes a preinstalled system software image. After a brief software unbundling process, the 
computer is ready to use.

If you prefer to replace the preinstalled software image with a customized set of system and application 
software, you can deploy a customized software image using either of the following methods:

● Installing additional software applications after unbundling the preinstalled software image

● Using a disk-cloning process to copy the contents from one hard drive to another

The HP Recovery Manager DVDs, ROM-based setup, and Advanced Configuration and Power Interface (ACPI) 
hardware provide further assistance with recovery of system software, configuration management and 
troubleshooting, and power management.

Support for specific features described in this guide can vary by model and software version.

The best deployment method depends on the information technology environment and processes.

Installing a remote system

When the computer has been configured as a remote system, you can start it and set it up by using software 
and configuration information on a network server. This feature is usually used for system setup and 
configuration and can be used to perform the following functions:

● Deploy a software image on new PCs

● Format a hard drive

● Install application software or drivers

● Update the operating system, application software, or drivers

To initiate a remote system installation, press F12 when F12=Network Service Boot appears in the lower 
right corner of the HP logo screen. Follow the onscreen instructions to continue the installation process. The 
default boot order can be changed in the BIOS so that the system always attempts to boot from the network.

Copying a setup configuration to another computer

This section provides information about replicating the computer setup.

CAUTION: Setup configuration is model specific. File system corruption can result if source and target 
computers are not the same model.

To copy a setup configuration:

1. Select a computer to use as the source of the setup configuration.

2. Connect a removable storage device to the computer, and then restart the computer.

3. As soon as the computer turns on, press and hold F10 until you enter Computer Setup (F10) Utility. If 
necessary, press Enter to bypass the title screen.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer, and then press 
and hold F10 to access the utility.

4. Select File, select Replicated Setup, and then select Save to Removable Storage Device. Follow the 
instructions on the screen to create the configuration file cpqsetup.txt and write it to a USB storage 
device.
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5. Turn off the computer you want to configure (the target computer), and connect the removable storage 
device that contains the configuration.

6. Turn on the target computer.

7. Press and hold the F10 key until you enter Computer Setup (F10) Utility. If necessary, press Enter to 
bypass the title screen.

8. Select File, select Replicated Setup, and then select Restore from Removable Storage Device. Follow 
the instructions on the screen.

9. Restart the computer when the configuration is complete.

Updating and managing software

HP provides several tools for managing and updating software on desktops and computers:

● LANDesk Software

● HP Driver Pack

● HP SoftPaq Download Manager

● System Software Manager

LANDesk Software

LANDesk and HP have partnered to help HP customers increase control over IT resources, reduce risks 
associated with owning them, and boost productivity within the IT environment.

Centrally leverage and manage the power of HP Professional Innovation tools with these features:

● Deployment and migration

● Remote assistance

● Mobile user and device management

● Energy conservation and power management

● HP hardware management

Go to http://www.landesk.com/partners/hp/client-management/ for more information about LANDesk Client 
Management Solutions for HP.

HP Driver Pack

The HP Driver Pack contains the Microsoft Windows drivers in an .INF-based installation format. This .INF 
installation method can be used alone or with bare-metal operating system deployment tools that 
require .INF based drivers. Select 32bit or 64bit to see a list of platforms (notebooks and tablets, 
workstations, and desktops) and the respective driver packs under the operating system. For more 
information, go to http://www8.hp.com/us/en/ads/clientmanagement/drivers-pack.html.

HP SoftPaq Download Manager

HP SoftPaq Download Manager is a free, easy-to-use interface for locating and downloading software 
updates for the HP client PC models in your environment. By specifying your models, operating system, and 
language, you can quickly locate, sort, and select the SoftPaqs you need. For more information, go to 
http://www8.hp.com/us/en/ads/clientmanagement/drivers-bios.html#softpaq-download-mng.
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HP System Software Manager

HP System Software Manager (SSM) is a utility that is available on Windows computers. It enables you to 
update system-level software on multiple systems simultaneously. When executed on a PC client system, 
SSM detects hardware and software versions and then updates the software from a central repository, known 
as a file store. Driver versions supported by SSM are noted with a special icon in the software, on the driver 
download website, and on the Support Software CD.

To download the utility or to obtain more information about SSM, go to http://www8.hp.com/us/en/ads/
clientmanagement/drivers-bios.html#system-sw-mng.

ROM Flash

BIOS settings are stored on a programmable flash ROM. By establishing a setup password in Computer Setup 
(F10) Utility, you can protect unauthorized users from modifying the BIOS settings. This function is important 
to be sure that the operating integrity of the computer.

To upgrade the BIOS, download the latest SoftPaq images from http://www.hp.com/support/
workstation_swdrivers.

Remote ROM Flash

Remote ROM Flash allows system administrators to safely upgrade the ROM on remote HP computers from a 
centralized network management console, resulting in a consistent deployment of, and greater control over, 
HP PC ROM images over the network.

To use Remote ROM Flash, the computer must be turned on, or turned on using Remote Wakeup.

For more information about Remote ROM Flash and HPQFlash, see the HP Client Manager Software or System 
Software Manager sections at http://www.hp.com/go/ssm.

HPQFlash

The HPQFlash utility is used to locally update or restore the system ROM on PCs using a Windows operating 
system. For more information about HPQFlash, go to http://www.hp.com/go/ssm, and enter the name of the 
computer.

FailSafe Boot Block 

FailSafe Boot Block enables BIOS recovery in the unlikely event of a ROM flash failure.

For example, if a power failure occurs during a ROM upgrade, Boot Block uses a flash-protected section of the 
ROM to verify a valid system ROM flash when power is restored to the computer.

If the system ROM is valid, the computer starts normally. If the system ROM fails the validation check, FailSafe 
Boot Block provides enough support to start the computer from a BIOS image CD that has been created from a 
SoftPaq. The BIOS image CD programs the system ROM with a valid image.

When Boot Block detects an invalid system ROM, the computer power LED blinks red eight times and the 
computer beeps eight times; then the computer pauses for two seconds. On some models, a Boot Block 
recovery mode message appears.

In preparation for system recovery, use the BIOS CD media file in the SoftPaq to create a BIOS image CD or 
USB flash drive.
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Recovering the computer from Boot Block Recovery mode

To recover the computer after it enters Boot Block recovery mode:

1. Remove any media such as USB flash drives or discs in the optical drives.

2. Insert a BIOS image CD into the DVD drive. You can also use USB media such as an HP DriveKey.

3. Turn the computer off, and then turn it on.

If no BIOS image CD or USB media is found, you are prompted to insert one and restart the computer.

If a setup password has been established, the Caps Lock light turns on and you are prompted for the 
password.

4. Enter the setup password.

If the computer starts from the boot media and successfully reprograms the ROM, three keyboard lights 
turn on and a rising-tone series of beeps signals successful recovery.

5. Remove the boot media and turn off the computer.

6. Restart the computer.

Workstation security

This section provides information about providing system security through asset tracking, password security, 
hard drive locking, and chassis locks.

Asset tracking

Asset tracking features provide data that can be managed using HP Systems Insight Manager (HP SIM), HP 
Console Management Controller (CMC), or other systems-management applications.

Seamless, automatic integration between asset tracking features and these products enables you to choose 
the management tool that is best suited to the environment and to leverage investments in existing tools.

HP also offers several solutions for controlling access to valuable components and information:

● Security features such as the Smart Cover Sensor (side access panel sensor) help prevent unauthorized 
access to the data and to the internal components of the computer

● Capability for protecting valuable data assets by disabling parallel, serial, or USB ports, or by disabling 
removable-media boot capability

● Memory Change and Side access panel sensor (Smart Cover Sensor) alerts, which can be forwarded to 
system management applications to deliver proactive notification of tampering with a computer’s 
internal components

The Smart Cover Sensor and cable lock are available as options on select systems.

You can manage security settings as follows:

● Locally, with Computer Setup (F10) Utility

● Remotely, with HP CMS or HP System Software Manager (SSM), which enable the secure, consistent 
deployment and control of security settings from a simple command line utility

For more information about Computer Setup (F10) Utility, see Computer Setup (F10) Utility menu on page 15.

The following Computer Setup (F10) Utility features let you manage computer security.
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Feature Purpose

Removable Media Boot Control Prevents booting from removable media drives

USB Interface Control Prevents transfer of data through the integrated USB interface

Power-On Password
Prevents use of the computer until the password is entered (applies to initial system 
startup and restarts)

Setup Password
Prevents reconfiguration of the computer (through Computer Setup (F10) Utility) until 
the password is entered

Network Server Mode Provides unique security features for computers used as servers

SATA hard drive security

HP computers include the HP DriveLock facility for SATA hard drives to prevent unauthorized access to data.

WARNING! Enabling DriveLock can render a SATA hard drive permanently inaccessible if the master 
password is lost or forgotten. No method exists to recover the password or access the data.

DriveLock has been implemented as an extension to Computer Setup (F10) Utility functions. It is only 
available when hard drives that support the ATA security command set are detected. On HP computers, it is 
not available when the SATA emulation mode is RAID.

DriveLock is for HP customers for whom data security is the paramount concern. For such customers, the cost 
of a hard drive and the loss of the data stored on it is inconsequential when compared to the damage that 
could result from unauthorized access to its contents.

To balance this level of security with the need to address the issue of a forgotten password, the HP 
implementation of DriveLock employs a two-password security scheme. One password is intended to be set 
and used by a system administrator, while the other is typically set and used by the user.

No "back door" can be used to unlock the drive if both passwords are lost. Therefore, DriveLock is most safely 
used when the data contained on the hard drive is replicated on a corporate information system or is regularly 
backed up.

If both DriveLock passwords are lost, the hard drive is inaccessible. For users who do not fit the previously 
defined customer profile, this outcome might not be acceptable. For users who fit this profile, the outcome 
might be a tolerable risk, given the nature of the data stored on the hard drive.

DriveLock applications

The most practical use of DriveLock is in a corporate environment. The system administrator would be 
responsible for configuring the hard drive, which involves setting the DriveLock master password and a 
temporary user password. If the system administrator forgets the user password or if the equipment is 
passed on to another employee, the master password can be used to reset the user password and restore 
access to the hard drive.

HP recommends that corporate system administrators who enable DriveLock also establish a corporate policy 
for setting and maintaining master passwords. This precaution will prevent loss of information if an employee 
sets both DriveLock passwords before leaving the company. In such a scenario, the hard drive is inaccessible 
and must be replaced. Likewise, by not setting a master password, system administrators might find 
themselves locked out of a hard drive and unable to perform routine checks for unauthorized software, other 
asset control functions, and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users in this 
category include personal users, or users who do not maintain sensitive data on their hard drives as a 
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common practice. For these users, the potential loss of a hard drive resulting from forgetting both passwords 
is much greater than the value of the data DriveLock protects.

Access to Computer Setup (F10) Utility and DriveLock can be restricted through the setup password. By 
specifying a setup password and not giving it to users, system administrators can restrict users from enabling 
DriveLock.

Using DriveLock

When hard drives that support the ATA security command set are detected, DriveLock appears under the 
Security menu in the Computer Setup (F10) Utility menu. You are presented with options to set the master 
password and to enable DriveLock. You must provide a user password to enable DriveLock. Because the initial 
configuration of DriveLock is typically performed by a system administrator, a master password should be set 
first.

HP encourages system administrators to set a master password whether they plan to enable DriveLock or 
not. This gives the administrator the ability to modify DriveLock settings if the drive is locked in the future. 
After the master password is set, the system administrator can enable DriveLock or leave it disabled.

If a locked hard drive is present, POST requires a password to unlock the device. If a power-on password is set 
and it matches the device’s user password, POST does not prompt the user to re-enter the password. 
Otherwise, the user is prompted to enter a DriveLock password.

For a cold start, use the master or user password. For a warm start, enter the same password used to unlock 
the drive during the preceding cold start.

Users have two attempts to enter a correct password. During cold start, if neither attempt succeeds, POST 
continues but the drive remains inaccessible. During a warm-start or restart from Windows, if neither attempt 
succeeds, POST halts and the user is instructed to cycle power.

Enabling DriveLock

To enable and set the DriveLock user password:

1. Turn on or restart the computer.

2. As soon as the computer is turned on, repeatedly press the F10 key until Computer Setup (F10) Utility 
starts.

If you do not press F10 at the appropriate time, you must restart the computer, and then repeatedly 
press F10 to access the utility.

3. Select Security and then select DriveLock Security.

4. For each DriveLock-capable drive, select the drive by pressing Enter.

5. Under Enable/Disable DriveLock options, select Enable, and then press Enter to enable DriveLock for 
that drive.

NOTE: To set the DriveLock master password, select Master.

CAUTION: If you forget the DriveLock password, the drive is inaccessible.

6. Enter a new user password (1 to 32 characters long), and then press Enter to accept.

Desktop management 29

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


7. Enter the password again in the Enter New Password Again field. If you forget this password, the drive 
is permanently disabled.

8. Select File and then select Save Changes and Exit. Press Enter to accept the changes. After you press 
Enter, the computer performs a cold start before invoking the DriveLock function.

When the computer starts, you are prompted to enter the DriveLock password for each DriveLock-
capable drive for which you have set a password. You have two attempts to enter the password 
correctly. If the password is not entered correctly, the computer attempts to start anyway. However, the 
boot process most likely fails because data from a locked drive cannot be accessed.

In a single-drive computer, when DriveLock is enabled, the computer might not be able to boot to the 
operating system, and might try to boot from the network or from another storage device (depending 
on the boot ordering options). Regardless of the outcome of the start attempts, the locked drive remains 
inaccessible without the DriveLock password.

In a two-drive computer that has a boot drive and a data drive, you can apply the DriveLock feature to 
the data drive only. In this case, the computer can always start, but the data drive is accessible only 
when the DriveLock password is entered.

Cold starts require that you enter DriveLock passwords. However, DriveLock passwords are also required 
for warm starts. For example, if you boot to DOS and press Ctrl+Alt+Del, you must enter the DriveLock 
password before the computer completes the next start cycle. This warm-start behavior is consistent 
with the DriveLock feature.

Password security

The power-on password prevents unauthorized access to applications or data when the computer is turned 
on or restarted. The setup password specifically prevents unauthorized access to the Computer Setup (F10) 
Utility and can also be used as an override to the power-on password. An administrator can enter the setup 
password at the prompt for the power-on password and gain access to the computer.

You can establish a network-wide setup password to enable the system administrator to log in to all network 
systems to perform maintenance without needing to know the power-on password.

Establishing a setup password using Computer Setup (F10) Utility

Establishing a setup password through the Computer Setup (F10) Utility prevents reconfiguration of the 
computer (through the use of Computer Setup (F10) Utility) until the password is entered.

To establish a setup password using the Computer Setup (F10) Utility menu:

1. Turn on or restart the computer.

2. As soon as the computer is turned on, repeatedly press the F10 key until you enter Computer Setup 
(F10) Utility.

If you do not press F10 at the appropriate time, you must restart the computer, and then repeatedly 
press F10 to access the utility.

3. Select Security and then select Setup Password. Follow the onscreen instructions.

4. Before exiting, select File and then select Save Changes and Exit.

Establishing a power-on password using computer setup

Establishing a power-on password through Computer Setup (F10) Utility prevents access to the computer 
when power is connected, unless you specify the password. When a power-on password is set, Computer 
Setup (F10) Utility presents Password Options in the Security menu. The password options include Network 
Server Mode and Password Prompt on Warm Boot.
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When Network Server Mode is disabled, you must enter the password when the computer is turned on and the 
key icon appears on the monitor. When Password Prompt on Warm Boot is enabled, you must enter the 
password. The password must also be entered each time the computer is restarted. When Network Server 
Mode is enabled, the password prompt is not presented during POST.

To enable Network Server Mode, you must set a power-on password under Advanced > Password Options. 
This option enables the computer to start without requiring the power-on password, but the keyboard and 
mouse are locked until you enter the password.

To establish a power-on password through the Computer (F10) menu:

1. Turn on or restart the computer.

2. As soon as the computer is turned on, repeatedly press the F10 key until you enter Computer Setup 
(F10) Utility.

If you do not press F10 at the appropriate time, you must restart the computer, and then repeatedly 
press F10 to access the utility.

3. Select Security > Power-On Password, and then follow the onscreen instructions.

4. Before exiting, select File > Save Changes and Exit.

Entering a power-on password

To enter a power-on password:

1. Restart the computer.

2. When the key icon appears on the monitor, enter the current password, and then press Enter.

Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful tries, you 
will enter the F10 setup screen with read-only permission. (See the Setup Browse Mode option under the 
Power-On options.)

Entering a setup password

If a setup password has been established on the computer, you will be prompted to enter it each time you run 
Computer Setup (F10) Utility.

To enter a setup password:

1. Restart the computer.

2. As soon as the computer is turned on, repeatedly press the F10 key until you enter Computer Setup 
(F10) Utility.

If you do not press F10 at the appropriate time, you must restart the computer, and then repeatedly 
press F10 to access the utility.

3. When the key icon appears on the monitor, enter the setup password, and press Enter.

Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful tries, you 
must restart the computer before you can continue.
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Changing a power-on or setup password

To change a power-on or setup password:

1. Restart the computer.

2. To change the power-on password, go to step 4.

3. To change the setup password, as soon as the computer is turned on, repeatedly press the F10 key until 
you enter Computer Setup (F10) Utility.

If you do not press F10 at the appropriate time, you must restart the computer, and then repeatedly 
press F10 to access the utility.

4. When the key icon appears, enter the current password, a slash (/) or alternative delimiter character, the 
new password, another slash (/) or alternative delimiter character, and the new password again as 
shown: 

current password/new password/new password

For information about the alternative delimiter characters, see National keyboard delimiter characters 
on page 33.

Type carefully. For security reasons, the characters you enter do not appear on the screen.

5. Press Enter.

The new password takes effect the next time you turn on the computer.

The power-on and setup passwords can also be changed using the Security options in Computer Setup (F10) 
Utility.

Deleting a power-on or setup password

To delete a power-on or setup password:

1. Turn on or restart the computer.

2. Choose from the following:

● To delete the power-on password, go to step 4.

● To delete the setup password, as soon as the computer is turned on, press and hold F10 until you 
enter Computer Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.

If you do not press F10 at the appropriate time, you must restart the computer and then press and 
hold F10 again to access the utility.

Use the appropriate operating system shutdown process.

3. When the key icon appears, enter the current password followed by a slash (/) or alternative delimiter 
character: current password/

For information about the alternative delimiter characters see the following section.

4. Press Enter.
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National keyboard delimiter characters

Each keyboard meets country-specific requirements. The syntax and keys you use for changing or deleting 
passwords depend on the keyboard included with the computer.

Language Delimiter  Language Delimiter  Language Delimiter

Arabic /  Greek -  Russian /

Belgian =  Hebrew .  Slovakian -

BHCSY * -  Hungarian -  Spanish -

Brazilian /  Italian -  Swedish/Finnish /

Chinese /  Japanese /  Swiss -

Czech -  Korean /  Taiwanese /

Danish -  Latin American -  Thai /

French !  Norwegian -  Turkish .

French Canadian é  Polish -  U.K. English /

German -  Portuguese -  U.S. English /

* Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia

Clearing passwords

If you forget the password, you cannot access the computer.

For instructions about clearing passwords, see Configuring password security and resetting CMOS 
on page 71.

Chassis security

Smart Cover Sensor

The Smart Cover Sensor, an optional feature, is a combination of hardware and software technology that 
alerts you if the interior or the computer is accessed (provided the sensor has been configured in Computer 
Setup (F10) Utility). The sensor alerts you when the side panel is removed (desktop and tower models) or 
when the computer is opened (all-in-one models). When the Smart Cover Sensor is installed, Smart Cover 
appears under the Security menu in the Computer Setup (F10) Utility menu.

Three levels of protection are available:

Level Setting Description

Level 0 Disabled Sensor * is disabled (default).

Level 1 Notify User
When the computer restarts, a message indicates that the computer has been 
opened or the access panel has been removed.

Level 2 Setup Password
When the computer restarts, a message indicates that the computer has been 
opened or the access panel has been removed. You must enter the setup password 
to continue.

* Smart Cover Sensor settings can be changed using Computer Setup (F10) Utility.

Desktop management 33

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


Setting the protection level

To set the Smart Cover Sensor protection level:

1. Turn on or restart the computer.

2. During startup, press and hold the F10 key until you enter Computer Setup (F10) Utility. Press Enter to 
bypass the title screen, if necessary.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the computer, and 
then press and hold the F10 key again to access Computer Setup (F10) Utility.

If you are using a PS/2 keyboard, you might see a keyboard error message. Disregard it.

3. Select Security > Smart Cover > Cover Removal Sensor, and follow the onscreen instructions.

4. Before exiting, select File > Save Changes and Exit.

Cable lock (optional)

To prevent theft, you can attach a keyed cable lock to the bottom-left corner of the chassis. This cable lock 
attaches to the chassis and secures it to the work area.

Fault notification and recovery

Fault notification and recovery features combine innovative hardware and software technology to prevent the 
loss of critical data and minimize unplanned downtime.

If the computer is connected to a network that is managed by HP CMS, the computer sends a fault notice to 
the network management application. With HP CMS, you can also remotely schedule diagnostics to run on 
managed PCs and create a summary report of failed tests.

ECC fault prediction

When the computer encounters an excessive number of error checking and correcting (ECC) memory errors, it 
displays a local alert message. This message contains information about the errant DIMM, enabling you to 
take action before you experience noncorrectable memory errors. ECC DIMMs are standard on this computer.

Thermal sensors

Several thermal sensors in the HP Workstation regulate computer fans to maintain an acceptable, efficient 
chassis temperature.

Dual-state power button

With ACPI enabled, the power button can function as an on/off switch or as a button. This feature does not 
completely turn off power, but instead causes the computer to enter a low-power standby state. This enables 
you to go to standby without closing applications, and to return to the same operational state without any 
data loss.
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Changing the power button configuration (Windows only)

CAUTION: To reduce the risk of data loss, do not use the power button to turn off the computer unless the 
system is unresponsive.

NOTE: If the computer is unresponsive, press and hold the power button for four seconds to completely turn 
off power to the computer.

Windows 7 or Windows 10

1. Select Start, and then select Control Panel > System and Security > Power Options.

2. In the left pane, click Choose what the power buttons do.

3. Select the desired options. 

If you choose Sleep or Hibernate, you can press the power button to initiate standby, and then press it again 
to exit standby and return to your work. To completely turn off the workstation, select Start > Shut Down.

Windows 8

1. Point to the upper-right or lower-right corner of the Start screen to display the charms.

2. Select Search.

3. In the Search field, type control.

4. Select Control Panel, and then select System and Security > Power Options.

5. Select Choose What the Power Button Does.

6. Select the desired options.
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3 Component replacement information and 
guidelines 

This chapter provides warnings, cautions, information, and guidelines for removal and replacement 
procedures. It does not document the step-by-step procedures.

IMPORTANT: Removal and replacement procedures are now available in videos on the HP website.

Go to the HP Customer Self Repair Services Media Library at http://www.hp.com/go/sml.

This chapter includes these topics:

Topics

Warnings and cautions on page 36

Service considerations on page 37

Product recycling on page 39

Component replacement guidelines on page 39

● Battery on page 39

● Cable management on page 40

● CPU (processor) and CPU heatsink on page 41

● Expansion slots on page 41

● Hard drives on page 42

● Memory on page 42

● Power supply on page 44

● Thermal sensors on page 45

Warnings and cautions
WARNING! These symbols on any surface or area of the equipment indicate the following: 

 Presence of a hot surface or hot component. If this surface is contacted, the potential for injury exists. To 

reduce the risk of injury from a hot component, let the surface cool before touching.

 Presence of an electrical shock hazard. To reduce the risk of injury from electrical shock, do not open any 

enclosed area marked with this symbol.

 Product must always be lifted by two persons to avoid personal injury due to product weight.
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WARNING! To reduce the risk of electric shock or damage to your equipment:

— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.

— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.

— Disconnect power from the equipment by unplugging the power cord from the electrical outlet.

WARNING! To reduce the risk of serious injury, read the Safety & Comfort Guide. It describes proper 
computer setup, posture, health, and work habits for computer users, and provides important electrical and 
mechanical safety information. This guide is located at http://www.hp.com/ergo.

WARNING! Do not use the front bezel as a handle or lifting point when lifting or moving the computer. 
Lifting the computer from the front bezel, or lifting it incorrectly, could cause the computer to fall, causing 
possible injury to you and damage to the computer. To properly and safely lift the computer, lift from the 
bottom of the computer.

CAUTION: Static electricity can damage the electronic components of the computer. To prevent damage to 
the computer, observe the following Electrostatic Discharge (ESD) precautions while servicing the computer:

— Discharge static electricity by briefly touching a grounded metal object before you begin.

— Work on a static-free mat.

— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your body to 
the ground.

— Create a common ground for the equipment you are working on by connecting the static-free mat, static 
strap, and peripheral units to that piece of equipment.

NOTE: HP accessories are for use in HP products. They have been extensively tested for reliability and are 
manufactured to high quality standards.

Service considerations

Tools and software requirements

You will need the following tools to complete the removal and replacement procedures:

● Torx T-15 driver

● Flat-blade and cross-tip screwdrivers

● Diagnostics software

Electrostatic discharge (ESD) information

Generating static Different activities generate different amounts of static electricity through electrostatic discharge (ESD). 
Static electricity increases as humidity decreases.

CAUTION: Static electricity in the amount of 700 volts might degrade a product.

Event
Relative humidity

55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

7,500V

3,000V

400V

15,000V

5,000V

800V

35,000V

12,000V

6,000V

Service considerations 37

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


Removing bubble pack from PCB

Packing PCBs in foam-lined box

7,000V

5,000V

20,000V

11,000V

26,500V

21,000V

Preventing ESD 
equipment damage

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree of 
sensitivity. To prevent damage to electronic components and accessories, observe the following 
packaging and grounding precautions:

● Transport products in static-safe containers such as tubes, bags, or boxes, to avoid hand contact.

● Protect electrostatic parts and assemblies with nonconductive or approved containers or 
packaging.

● Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from containers.

● Before handling or touching a sensitive component or assembly, ground yourself by touching the 
chassis.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or 
nonconductive foam.

Personal grounding 
methods and 
equipment

Use the following items to help prevent ESD damage:

● Wrist straps — These are flexible straps with a maximum of one megohm ± 10% resistance in the 
ground cords. To provide a proper ground, wear the strap against bare skin. The ground cord must 
be connected and fit snugly into the banana plug connector on the grounding mat or computer.

● Heel straps, toe straps, and boot straps — These can be used at standing computers and are 
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use 
them on both feet with a maximum of one megohm ± 10% resistance between the operator and 
ground.

Static shielding 
materials

Static shielding materials provide the following levels of protection.

Method

Antistatic plastic

Carbon-loaded plastic

Metalized laminate

Voltage

1,500V

7,500V

15,000V

Grounding the work 
area to prevent static 
damage

● Cover the work surface with approved 
static-dissipative material. Use a wrist strap 
connected to the work surface, and properly 
grounded tools and equipment.

● Use static-dissipative mats, foot straps, or 
air ionizers to give added protection.

● Handle electrostatic-sensitive components, 
parts, and assemblies by the case or PCB 
laminate. Handle them only in static-free 
work areas.

● Disconnect power and input signals before 
inserting and removing connectors or test 
equipment.

● Use fixtures made of static-safe materials 
when fixtures must directly contact dissipative 
surfaces.

● Keep work area free of nonconductive 
materials, such as plastic assembly aids and 
Styrofoam.

● Use field service tools (such as cutters, 
screwdrivers, and vacuums) that are 
conductive.

Recommended ESD 
prevention materials 
and equipment

● Antistatic tape

● Antistatic smocks, aprons, and sleeve 
protectors

● Conductive bins and other assembly or 
soldering aids

● Conductive foam

● Static awareness labels

● Wrist straps and footwear straps providing one 
megohm ± 10% resistance

● Material-handling packages

● Conductive plastic bags

38 Chapter 3   Component replacement information and guidelines

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


● Conductive tabletop computers with a 
ground cord of one megohm ± 10% 
resistance

● Static-dissipative table or floor mats with a 
hard-tie to ground

● Field service kits

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes

Product recycling
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable 
batteries.

For information about recycling HP components or products, go to http://www.hp.com/go/recycle.

Component replacement guidelines
This section provides information and guidelines for removal and replacement procedures. It does not 
document the step-by-step procedures.

IMPORTANT: Removal and replacement procedures are now available in videos on the HP website.

Go to the HP Customer Self Repair Services Media Library at http://www.hp.com/go/sml. In Media Selection, 
choose Desktops & Workstations for product category and Personal Workstations for the product family, 
and then choose your platform.

This chapter provides guidelines for removal and replacement procedures.

Topics

Battery on page 39

Cable management on page 40

CPU (processor) and CPU heatsink on page 41

Expansion slots on page 41

Hard drives on page 42

Memory on page 42

Power supply on page 44

Thermal sensors on page 45

Battery 

The battery that comes with the computer provides power to the real-time clock and has a minimum lifetime 
of about three years. Observe the following warning and caution when replacing the battery.

CAUTION: Before removing the battery, back up the CMOS settings in case they are lost when the battery is 
removed. To back up the CMOS settings, select the Save to Removable Storage option in Computer Setup 
(F10) Utility. 

NOTE: Do not dispose of batteries, battery packs, and accumulators with general household waste.
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Cable management

Proper routing of the internal cables is critical to the operation of the workstation. Follow good cable 
management practices when removing and installing components.

● Handle cables with care to avoid damage.

● Apply only the tension required to seat or unseat cables during insertion or removal from the connector.

● When possible, handle cables by the connector or pull-strap.

● Route cables in such a way that they cannot be caught or snagged by parts being removed or replaced.

● Keep cables away from direct contact with major heat sources, such as the heatsink. (Some air flow 
guides have a cable guide that lets you route cables safely around the heatsink.)

● Do not jam cables on top of expansion cards or DIMMs. Circuit cards and DIMMs are not designed to take 
excessive pressure.

● Keep cables clear of movable or rotating parts (such as the power supply and drive cage) to prevent 
them from being cut or crimped when the component is lowered into its normal position.

● When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the wires.

● In all cases, avoid bending or twisting the cables. Do not bend any cable sharply. A sharp bend can break 
the internal wires.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables down 
into the chassis. Always position the cables to lay properly by themselves or in the cable guides and 
chassis areas designed for cable routing.

When removing the power supply power cable from the connector on the system board, always follow these 
steps:

1. Press down the top of the retaining latch attached to the cable end of the connector.

2. Grasp the cable end of the connector and pull it straight out.

CAUTION: Always pull on the connector — NEVER pull on the cable. Pulling on the cable could damage 
the cable and result in a failed power supply.
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CPU (processor) and CPU heatsink 

CAUTION: Observe the following cautions when removing or replacing the heatsink:

— When removing the heatsink, loosen all screws a little at a time to be sure that the CPU remains level. Do 
not fully loosen one screw, and then move on to the next.

— Do not overtighten the heatsink screws. Overtightening can strip the threads in the chassis.

CAUTION: Observe the following cautions when removing or replacing the CPU.

— Internal components might be powered even when the computer is off. To prevent damage, disconnect the 
computer power cord before you remove or install a component.

— Do not touch the CPU socket contacts or the gold pads underneath the CPU. Use extreme care and handle 
the CPU only by the edges.

— The CPU socket contacts are delicate and bend easily. To avoid bending the contacts, use extreme care 
when installing the CPU in the socket.

— Installing a processor incorrectly can damage the system board. Contact an authorized service provider to 
install the processor. If you plan to install the processor yourself, view the entire remove-and-replace video 
before you begin.

— Failure to follow the computer preparation instructions can result in an improperly installed processor, 
causing extensive computer damage.

Expansion slots 

The workstation has the following expansion slots:

● One MXM slot that supports Type A and Type B cards (dedicated for graphics)

● Two Mini PCIe/mSATA slots that support mSATA devices or full-length Mini PCIe cards. Half-length cards 
require an extender plate.

Go to http://www.hp.com/go/quickspecs to learn which cards are supported in the workstation.

CAUTION: To prevent damage, the overall power consumption of the computer (including I/O cards, CPU, 
and memory) must not exceed the maximum rating of the computer power supply. For power supply 
information, see Power supply specifications on page 44.
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Hard drives

● To verify the type, size, and capacity of the storage devices installed in the computer, run Computer 
Setup (F10) Utility.

● The workstation supports SATA hard drives or mSATA devices.

● The workstation requires one of the following supported carriers:

◦ 671193-001 supports one 3.5-in hard drive

◦ 671192-001 supports one or two 2.5-in hard drives or solid-state drives

● Combining a 2.5-in hard drive and 3.5-in hard drive is not possible.

● No cable adapters are required for any hard drives. The cables necessary for all hard drive configurations 
are included in the base system and automatically “blind mate” or “direct connect” to the drive(s) when 
installed.

● The workstation supports mSATA devices in the Mini PCIe/mSATA slots.

Handling hard drives

CAUTION: Take proper precautions when handling hard drives to prevent loss of work and damage to the 
computer or drive.

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective 
packaging until they are mounted in the computer.

● Always shut down the operating system, turn off the power, and unplug the power cord. Never remove a 
drive while the computer is on or in standby mode.

● Before handling a drive, be sure that you discharge static electricity. While handling a drive, avoid 
touching the connector.

● Handle a drive carefully. Do not drop it from any height.

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 
such as monitors or speakers.

● If you must mail a drive, use a bubble-pack mailer or other protective packaging and label the package 
“Fragile: Handle With Care.”

Memory

Supported DIMM configurations

The HP Z1 G2 Workstation has 4 DIMM slots and supports up to 32 GB ECC or 16 GB non-ECC unbuffered DDR3 
1866 MHz memory.

NOTE: Mirroring and DIMM sparing are not supported.

● Four DIMM slots

● Maximum capacity: 32 GB

● Error checking and correcting (ECC) and non-ECC DIMMs only.
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BIOS errors and warnings

The BIOS generates warnings/errors on invalid memory configurations:

● If the BIOS can find a valid memory configuration by disabling plugged-in memory, it does so and 
reports a warning during POST. The workstation can still be started. The warning will indicate the 
location of the failed DIMM on the system board.

● If there is no way for the BIOS to obtain a valid memory configuration by disabling plugged-in memory, 
the BIOS halts with a diagnostics 2006 code for memory error (five beeps and blinks).

DIMM installation guidelines

● Install only HP-approved DDR3 DIMMs

CAUTION: HP ships only DIMMs that are electrically and thermally compatible with this computer. 
Because third-party DIMMs might not be electrically or thermally compatible, they are not supported by 
HP. 

● For ECC DIMMs, use only industry-standard ECC unbuffered DIMMs. Go to http://www.hp.com/go/
quickspecs to find which DIMMs are compatible with the computer.

● Do not intermix non-ECC memory DIMMs with ECC memory DIMMs.

CAUTION: DIMMs and their sockets are keyed for proper installation. To prevent socket or DIMM damage, 
align these guides properly when installing DIMMs.

DIMM installation order

Install DIMMs in this order.

CAUTION: Internal components might be powered even when the computer is off. To prevent damage, 
disconnect the computer power cord before you remove or install a component.
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Power supply 

The workstation includes a 400W 90% efficient power supply that is compatible with ENERGY STAR 
requirements.

Power supply specifications

Power supply 400 W wide-ranging, active Power Factor Correction, 90% 
efficient

Operating voltage range 90–264 V ac

Rated voltage range 100–240 V ac

Rated line frequency 50–60 Hz

Operating line frequency range 47–63 Hz

Rated input current 5A @ 100–240 V

Heat dissipation, typical

(configuration and software dependent)

253 btu/hr (64 kg-cal/hr)

Heat dissipation, maximum

(configuration and software dependent)

1569 btu/hr (395 kg-cal/hr)

Power supply fan

All fans are variable speed

Two variable speed fans, 40 mm x 20 mm

Built-in Self Test LED Yes

Power Consumption in sleep mode (as defined by ENERGY 
STAR) - Suspend to RAM (S3)

< 4 W

ENERGY STAR® Version 6.0 qualified (Config Dependent) Yes

FEMP Standby Power Compliant Yes, < 1 W in S5-Power Off @ 115 V ac

Surge tolerant, full-ranging (withstands power surges up to 
2000 V)

Yes

ErP Lot 6-Tier 1 compliance @ 230 V (<1 W in S5-Power Off) Yes

ErP Lot 6-Tier 2 compliance @ 230 V (<0. W in S5-Power Off) Yes
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Power consumption and heat dissipation

Power consumption and heat dissipation specifications are available for multiple configurations. To review 
available specifications, go to http://www.hp.com/go/quickspecs.

To reach zero power consumption, unplug the workstation from the power outlet or use a power strip with an 
on/off switch. For additional information about power-saving features, see the operating system installation 
instructions.

This product is in compliance with U.S. Executive Order 13221 (FEMP).

Resetting the power supply

If an overload triggers the power supply overload protection, power is immediately disconnected.

To reset the power supply:

1. Disconnect the power cord from the workstation.

2. Determine what caused the overload, and fix the problem. For troubleshooting information, see 
Diagnostics and troubleshooting on page 46.

3. Reconnect the power cord, and restart the workstation.

When you turn off the workstation through the operating system, power consumption falls below what is 
considered low power consumption but does not reach zero. Power consumption only reaches zero when you 
unplug the workstation from the power outlet.

Thermal sensors

The following illustration shows the locations of the thermal sensors. Sensors that attach with a harness can 
be replaced.

1 Memory VR sensor 4 MXM GPU sensor 7 Drive 1 sensor

2 12 V–3.3 V VR sensor 5 CPU0 VR sensor 8 Drive 2 sensor

3 Backlight VR sensor 6 CPU0 DTS sensor (inside processor) 9 Inlet air sensor
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4 Diagnostics and troubleshooting 

This chapter describes the tools available for diagnosing and troubleshooting system issues.

Topics

Calling support on page 47

Locating ID labels on page 48

Locating warranty information on page 48

Diagnosis guidelines on page 49

Troubleshooting checklist on page 50

HP troubleshooting resources and tools on page 50

Troubleshooting scenarios and solutions on page 53

Using HP PC Hardware Diagnostics (UEFI) on page 62

Diagnostic codes and errors on page 63
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Calling support
At times you might encounter an issue that requires support. When you call support:

● Have the computer readily accessible.

● Write down the computer serial numbers, product numbers, model names, and model numbers and 
have them in front of you.

● Note any applicable error messages.

● Note any add-on options.

● Note the operating system.

● Note any third-party hardware or software.

● Note the details of any blinking LEDs on the front of the computer (tower and desktop configurations) or 
on the side of the computer (all-in-one configurations).

● Note the applications you were using when you encountered the problem.

NOTE: When calling in for service or support, you might be asked for the product number (example: 
PS988AV) of the computer. If the computer has a product number, it is generally located next to the 10- or 12-
digit serial number of the computer.

NOTE: On most models, the serial number and product number labels can be found on the top or side panel 
and at the rear of the computer (tower and desktop configurations) or on a pull-out card on the side of the 
display (all-in-one configurations).

For a listing of all worldwide support phone numbers, go to http://www.hp.com/support, select your region, 
and click Connect with HP in the upper-right corner.
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Locating ID labels
To assist in troubleshooting, product, serial, and authentication numbers are available on each computer.

● All workstations have a serial number (unique for each workstation) and product number. Have these 
numbers available when you contact support.

● The Certificate of Authentication (COA) is used only for systems with Windows 7 preinstalled.

● The Genuine Microsoft Label (GML) is used only for systems with Windows 8 preinstalled.

● A service label shows the build ID and Feature Byte strings, which are needed for system board 
replacement.

The all-in-one service label can be found in the location shown in the figure below (pull-out card).

Locating warranty information
To locate base warranty information, see http://www.hp.com/support/warranty-lookuptool.

To locate an existing Care Pack, see http://www.hp.com/go/lookuptool.

To extend a standard product warranty, visit http://www.hp.com/hps/carepack. HP Care Pack Services offer 
upgraded service levels to extend and expand a standard product warranty.
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Diagnosis guidelines
If you encounter a problem with the computer or software, consult the following sections. They provide a list 
of general suggestions that help you isolate and focus on the problem before taking further action.

Diagnosis at startup

● Verify that the computer and external monitor (if connected) are plugged into a functional AC power 
outlet.

● Remove all CDs or USB flash drives from your system before turning it on.

● Verify that the computer is turned on and the power light is blue (normal operation) and not red (error 
state).

● If you have installed an operating system other than the factory-installed operating system, go to 
http://www.hp.com/go/quickspecs to verify that it is supported on your system.

Diagnosis during operation

● Look for blinking LEDs on the side of the computer. The blinking lights are error codes that will help you 
diagnose the problem. See Diagnostic LED and audible (beep) codes on page 63 for information on 
interpreting diagnostic lights and audible codes.

● Verify that all cables are not loosely or incorrectly connected.

● Wake the computer by pressing any key on the keyboard or the power button. If the system remains in 
suspend mode, shut down the system by pressing and holding the power button for at least four 
seconds, and then press the power button again to restart the system. If the system does not shut 
down, unplug the power cord, wait a few seconds, and then plug it in again. If it does not restart, press 
the power button to start the computer.

● Restart the computer after installing a non–Plug and Play (PnP) expansion board or other option.

● Be sure that all required device drivers have been installed. For example, if you have connected a printer, 
you must install a printer driver.

● If you are working on a network, plug another computer with a different cable into the network 
connection. There might be a problem with the network plug or cable.

● If you recently added new hardware, remove it and see if the computer functions properly.

● If you recently installed new software, uninstall it and see if the computer functions properly.

● Upgrade the BIOS. A new release of the BIOS might have been released that supports new features or 
fixes your problem.

● Press the Caps Lock key. If the Caps Lock LED toggles on or off, the keyboard is operating correctly.
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Troubleshooting checklist
Before running diagnostic utilities, use the following checklist to find possible solutions for computer or 
software problems.

● Is the computer connected to a functional AC power outlet?

● Is the computer turned on?

● Is the blue power light on?

● If the internal display is dim, adjust the internal display brightness and contrast controls.

● Press the Caps Lock key several times. If the Caps Lock LED toggles on and off, the keyboard is operating 
correctly.

● Verify that all cables are not loosely or incorrectly connected.

● After installing a non-PnP expansion board or other option (such as a diskette drive), restart the 
computer.

● Are all necessary device drivers installed?

● Have all printer drivers been installed for each application?

● Have you removed CDs and USB flash drives before powering on the computer?

● Are you running the latest version of BIOS, drivers, and software?

HP troubleshooting resources and tools
This section provides information on the HP Support Center (HPSC), Online support, and Helpful Hints for 
troubleshooting.

Online support

Online access and support resources include web-based troubleshooting tools, technical knowledge 
databases, driver and patch downloads, online communities, and product change notification services.

The following websites are also available to you:

● http://www.hp.com—Provides useful product information.

● http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.

● http://www.hp.com/go/workstationsupport—Provides technical support information for workstations.

● http://www.hp.com/support—Provides a listing of the worldwide technical support phone numbers. 
Access the telephone numbers by visiting the website, then select your region, and click Contact HP in 
the upper-left corner.

● http://www.hp.com/support/workstation_swdrivers—Provides access to software and drivers for 
workstations.
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Troubleshooting a problem

To help you troubleshoot problems with your system, HP provides the HPSC. The HPSC is a portal to an 
extensive selection of online tools. To access HPSC and troubleshoot a problem with the workstation, 
complete the following:

1. Go to http://www.hp.com/go/workstationsupport.

2. Specify your product.

3. Under the Support Options menu on the left, select Troubleshoot a problem and then select the 
appropriate category in the resulting menu on the right.

Customer Advisories, Bulletins, Notices, and Product Change Notifications

To find advisories, bulletins, and notices:

1. Go to http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. Under Knowledge Base, select Advisories, Bulletins & Notices.

Product Change Notifications

Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a 30-60 
day window of the effective date of the change in the manufacturing process. PCNs give customers advanced 
notice of changes to their product, such as an updated BIOS version that they may need to qualify prior to the 
change taking place. The latest PCNs are located at: http://www.hp.com/go/workstationsupport.

Helpful hints

If you encounter a problem with the workstation, monitor, or software, the following general suggestions 
might help you isolate and focus on the problem before taking further action.

At startup

● Verify that the workstation and monitor are plugged into a working electrical outlet.

● Remove all optical discs and USB drive keys from the drives before powering on the workstation.

● Verify that the workstation is turned on and the power light is on.

● If you have installed an operating system other than the factory-installed operating system, check to be 
sure that it is supported on your system, go to http://www.hp.com/go/quickspecs.

● Verify that the monitor is turned on and the power light is on.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● If the workstation has multiple video sources and only a single monitor, the monitor must be connected 
to the source selected as the primary VGA adapter. During startup, the other monitor connectors are 
disabled; if the monitor is connected to one of these ports, it will not function after Power-on Self Test 
(POST). You can select the default VGA source in Computer Setup (f10) Utility.
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During operation

● Look for blinking LEDs on the workstation. The blinking lights are error codes that will help you diagnose 
the problem. Refer to the Diagnostic lights and audible (beep) codes section of this document for 
information on interpreting diagnostic lights and audible codes.

● Press and hold any key. If the system beeps, then your keyboard is operating correctly.

● Check all cables for loose or incorrect connections.

● Wake the workstation by pressing any key on the keyboard or the power button. If the system remains in 
suspend mode, shut down the system by pressing and holding the power button for at least four 
seconds, then press the power button again to restart the system. If the system does not shut down, 
unplug the power cord, wait a few seconds, then plug it in again. If it does not restart, press the power 
button to start the workstation.

● Reconfigure the workstation after installing a non–plug and play expansion board or other option. Refer 
to the Hardware installation problems section of this document for instructions.

● Be sure that all required device drivers have been installed. For example, if you have connected a printer, 
you must install a printer driver.

● If you are working on a network, plug another workstation with a different cable into the network 
connection. There might be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and verify if the workstation functions 
properly.

● If you recently installed new software, uninstall the software and verify if the workstation functions 
properly.

● If the monitor connected to a tower, desktop or all-in-one computer is blank:

◦ Plug the monitor into a different video port on the computer if one is available. Alternatively, 
replace the monitor with a monitor that you know is working properly.

◦ Verify that the computer and monitor are plugged into a working electrical outlet.

◦ Verify that the monitor is turned on and the power light is on.

◦ Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● If the internal display on an all-in-one computer is blank, open the computer and make sure the graphics 
card is properly installed.

● Upgrade the BIOS. A new release of the BIOS might have been released that supports new features or 
fixes your problem.

Customer Self-Repair program

Under the Customer Self-Repair program, you can order a replacement part and install the part without onsite 
HP technical assistance. Customer self-repair may be required for some components. See 
http://www.hp.com/go/selfrepair for information on the program.

NOTE: Some components are not eligible for customer self-repair and must be returned to HP for service. 
Call HP Support for further instructions before attempting to remove or repair these components.
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Troubleshooting scenarios and solutions
This section presents an extensive overview of various troubleshooting scenarios and possible solutions for a 
Windows-based computer.

Solving minor problems

Problem Cause Possible Solution

Workstation appears frozen 
and does not shut down when 
the power button is pressed.

Software control of the power 
switch is not functional.

1. Press and hold the power button for at least four seconds 
until the computer shuts down.

2. Disconnect the electrical plug from the outlet.

Workstation seems to be 
frozen.

Program in use has stopped 
responding to commands.

1. If possible, use the Windows Task Manager to isolate and 
terminate the offending process.

2. Attempt the normal Windows shutdown procedure.

3. Restart the computer using the power button.

Workstation date and time 
display is incorrect.

Real-time clock (RTC) battery 
might need replacement.

1. Reset the date and time in the Control Panel.

2. Replace the RTC battery.

Workstation appears to pause 
periodically.

Network driver is loaded and 
no network connection is 
established.

Establish a network connection, or use Computer Setup (F10) 
Utility or the Windows Device Manager to disable the network 
controller.

Cursor does not move using 
the arrow keys on the keypad.

The Num Lock key 
might be on.

Press Num Lock. The Num Lock key can be disabled or enabled 
in Computer Setup (F10) Utility.

Poor performance is 
experienced.

Processor is hot. 1. Verify that airflow to the computer is not blocked.

2. Verify that chassis fans are connected and working 
properly. Some fans operate only when needed.

3. Verify that the processor heatsink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on the 
hard drive.

Workstation turned off 
automatically and the power 
LED flashes red two times 
(once per second), followed by 
a two second pause, and then 
two consecutive beeps.

Processor thermal protection 
is activated.

A fan might be blocked or not 
turning.

OR

The processor heatsink is not 
properly attached to 
the processor.

1. Verify that the computer air vents are not blocked.

2. Open the access panel and press the computer power 
button.

3. Verify that the system fan is running.

4. Verify that the processor heatsink fan spins. If the fan is 
not spinning, verify that the heatsink fan cable is plugged 
into the system board connector and that the heatsink is 
properly seated.

5. Replace the processor heatsink.

System does not turn on, and 
the LEDs on the side of the 
computer are not flashing.

System cannot turn on. Press and hold the power button for less than four seconds. If 
the hard drive LED turns green, then perform the following 
steps.

1. To find a faulty device, remove all devices one at a time:

a. Disconnect AC power to the computer.

b. Remove a device.

c. Reconnect AC power and turn on the computer.
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Problem Cause Possible Solution

2. Repeat this process until the faulty device is identified. 
Remove the graphics card last. Replace the faulty device.

3. If no faulty device is found, replace the system board.

OR

1. Press and hold the power button for less than four 
seconds. If the hard drive LED does not turn on, then 
perform the following tasks:

a. Verify that the computer is plugged into a working 
AC outlet.

b. Verify that the power button harness is connected to 
the inline front panel I/O device assembly connector.

2. Verify that the power supply cables are connected to the 
system board.

3. Verify power supply with PSU functionality.

a. Disconnect the AC power.

b. Unplug the DC cables from the PSU.

c. Reconnect AC power.

● If the PSU fan spins and the BIST LED illuminates, 
the PSU is good; replace the system board.

● If the PSU does not spin or the LED does not 
illuminate, replace the PSU.

Workstation will not start. Hard drive is damaged. Replace the hard drive.

Solving hard drive problems

Problem Cause Solution

Hard drive error occurs. Hard drive has bad 
sectors or has failed.

Locate and block the usage of bad sectors. If necessary, reformat the hard 
drive.

If the drive is detected by the UEFI, run F2 Diagnostics Drive Test.

Hard drive transaction 
problem.

The directory structure is 
bad, or there is a problem 
with a file.

1. In Windows Explorer, select the drive.

2. Enable the context menu and select Properties.

3. In the Properties dialog, select the Tools tab and select Check Now.

Drive not found 
(identified).

Improper cable 
connection

On computers with discrete data and power cables, verify that the data 
and power cables are securely connected to the hard drive. (See the Hard 
drive section of this guide for connection details.)

Improperly seated hard 
drive

On systems with blind-mate drive connections, verify that there is no 
connector damage on the drive or in the chassis.

Reseat the hard drive and its carrier in the chassis to be sure that there is 
a proper connection. (See the Hard drive section of this guide for 
connection details.)

The system might not 
have automatically 

Perform one or both of the following:
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Problem Cause Solution

recognized a newly 
installed device.

● Verify that the drive is listed in the Computer Setup (F10) Utility 
(Storage>Device Configuration). If it is listed, the probable cause is a 
driver problem. If it is not listed, the probable cause is a hardware 
problem.

● If this drive is newly installed, run the Computer Setup (F10) Utility 
and increase the POST Delay in Advanced > Power-On Options.

Drive responds slowly 
immediately after power-
up.

Run the Computer Setup (F10) Utility, and increase the POST Delay in 
Power-On Options in the Advanced menu.

Nonsystem disk or 
NTLDR missing 
message.

System is trying to start 
from non-bootable 
media.

Remove the media device.

System is trying to start 
from a damaged hard 
drive.

1. Insert bootable media and restart the computer.

2. If the hard drive is still inaccessible and MBR Security is enabled, try 
restoring the previously saved MBR image by entering the Computer 
Setup (F10) Utility and selecting Security > Restore Master Boot 
Record.

System files missing or 
not properly installed.

1. Insert bootable media and restart the computer.

2. Verify that the hard drive is partitioned and formatted.

3. Install the system files for the appropriate operating system, 
if necessary.

Hard drive boot disabled 
in Computer Setup.

Run the Computer Setup (F10) Utility and enable the hard drive entry in 
the Storage>Boot Order list.

 Boot Order Incorrect Run Computer Setup (F10) Utility and set the correct order in Storage 
>Boot Order. Of special note, an mSATA drive will have a higher SATA port 
number than drives in the regular HDD bays. If drives are removed and the 
system rebooted, the boot order may be changed by the BIOS and would 
need to be reset to the desired order. The F9 Boot Order menu can be used 
to check and choose the right drive for boot.

Solving internal display problems

Problem Cause Solution

Blank screen (no video). Cable connections are 
not correct.

1. Verify the LCD display cable connection to J65 on the system board 
and to the internal LCD panel connector.

2. Verify the LED backlight cable connection to P2 on the system board 
and to the LED power connector on the internal LCD panel.

Screen blanking utility 
installed or energy 
saver features enabled.

Press a key or the mouse button and, if set, enter your password.

System ROM is bad; 
system is running in 
FailSafe Boot Block 
mode (indicated by 8 
beeps).

Reflash the ROM using a SoftPaq.

Computer is in 
Hibernate mode.

Press the power button to resume from Hibernate mode.
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Problem Cause Solution

Backlight circuit on 
motherboard is 
damaged.

Replace the motherboard.

 The key sequence that 
switches the 
DisplayPort connector 
from internal graphics 
source to external 
graphics source was 
pressed, but there is no 
external source (such 
as a laptop) for 
graphics.

On the workstation keyboard:

1. Simultaneously press Ctrl + Shift + S+D (switch display). This reverts 
the workstation to internal graphics source and places the 
workstation display in standby mode.

2. Press the space bar (or move the mouse) to wake up the display.

The display works 
properly during the POST 
but goes blank when the 
operating system starts.

The display settings in 
the operating system 
are incompatible with 
the internal LCD panel.

For Windows:

1. Restart your computer in Windows Safe Mode.

2. Uninstall the graphics driver for the graphics controller (Intel HD 
Graphics or NVIDIA Graphics).

3. Reboot in normal Windows mode.

4. Install the latest graphics driver for the graphics controller you are 
using (Intel HD Graphics or NVIDIA Graphics).

Backlight level is turned 
all the way down in 
software environment 
settings

 This can happen if a utility has been used to set it to a very low level. 
Resetting to a usable value requires actions typically using the same utility 
that was originally used. Some OSes and environments may have other 
means for resetting.

Power LED flashes red 6 
times (once every 
second), followed by a 2-
second pause, and then 
the computer beeps 6 
times.

Prevideo graphics error. Try these solutions in this order:

● Reseat the graphics card if using nVidia graphics; reseat the 
processor if using Intel HD Graphics.

● Replace the graphics card if using nVidia graphics or replace the 
processor if using Intel HD graphics.

● Replace the system board.

Processor does not 
support graphics 
output and no discrete 
graphics card is 
installed.

Try either solution:

● Install a processor with Intel HD Graphics.

● Install a supported graphics card.

Dim characters Brightness and contrast 
controls are not set 
properly.

In Windows, go to Control Panel, select Power Options, and then adjust 
the internal LCD panel brightness and contrast controls using the Screen 
Brightness slider bar at the bottom of the window.

Cables are not properly 
connected.

1. Open the computer.

2. Verify that the LCD Display Cable connects J65 on the system board 
to the internal LCD panel connector.

3. Verify that the LED Backlight Cable connects P2 on the system board 
to the LED power connector on the internal LCD panel.

Blurry video or requested 
resolution cannot be set.

Correct video drivers 
were not loaded after 
graphics controller 
upgrade.

Install the video drivers included in the upgrade kit, or download and 
install the latest drivers for your graphics card from 
http://welcome.hp.com/country/us/en/support.html.
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Problem Cause Solution

The internal LCD panel 
cannot display 
requested resolution.

1. Change the resolution to either 2560 x 1440 or 1280 x 720.

2. Update the graphics driver to the latest version available for your 
graphics controller.

The graphics driver is 
not working properly.

1. Boot into the OS and uninstall the graphics driver.

2. Restart the computer.

3. Install the latest graphics driver for your graphics controller.

The picture is broken up, 
rolls, jitters, or flashes.

The internal LCD panel 
connections to the 
motherboard might be 
faulty or the panel 
might be incorrectly 
adjusted.

1. Open the computer.

2. Verify the LCD display cable connects J65 on the system board to the 
display connector on the internal LCD panel.

3. Verify that the LED backlight cable connects P2 on the system board 
to the LED power connector on the internal LCD panel.

The graphics driver is 
not working properly.

1. Boot into the OS and uninstall the graphics driver.

2. Reboot.

3. Install the latest graphics driver for your graphics controller.

Some typed symbols do 
not appear correctly.

The font you are using 
does not support that 
symbol.

Use the Character Map to locate and select the appropriate symbol.

(Windows 7) Select Start > All Programs > Accessories > System Tools > 
Character Map. (Windows 8) Display the charms and select Search. In the 
Search field, type character, then select Character Map. Copy the 
symbol from the Character Map into a document. (Windows 10) Type 
character in the taskbar search box, and then select Character Map.

The LCD panel 
resolution is not 
properly set.

Use one of the following:

● Change the panel resolution in the Windows Control Panel by 
navigating to Appearance and Personalization > Display. Click 
Change display settings then adjust the resolution.

● Use the control panel for the graphics controller (Intel or nVidia).

The graphics driver 
does is not working 
properly or does not 
support the symbol set 
with that resolution.

Try either solution:

● Change the panel resolution using either of the following: 1) Change 
the panel resolution in the Windows Control Panel by navigating to 
Appearance and Personalization > Display. Click Change display 
settings then adjust the resolution. or 2) Use the control panel for 
the graphics controller (Intel or nVidia).

● Install the latest graphics driver:

1. Boot into the OS and uninstall the graphics driver.

2. Restart the computer.

3. Install the latest graphics driver for your graphics controller.

Integrated Graphics 
comes up in OS when 
using an MXM

MXM is inserted 
incorrectly

1. Open the system and locate the MXM graphics module.

2. Carefully remove the MXM graphics module by squeezing on the 
retention tab and gently pulling the card from the MXM slot.

3. Take the module and align the card’s connector parallel to the 
motherboard MXM slot.

4. Gently insert the card at a 45 degree angle from the bottom of the 
motherboard into the slot.
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Problem Cause Solution

NOTE: Maintain the card parallel with the motherboard slot when 
inserting the card!

Solving externally connected display problems

Problem Cause Solution

Blank screen (no video). The cable connections are not 
correct.

Verify the cable connections from the monitor to the computer 
and to a working AC outlet.

The monitor is off. Turn the monitor on (LED is on). You might need to refer to the 
monitor manual for an explanation of LED signals.

Screen blanking utility installed or 
energy saver features enabled.

Press a key or the mouse button and, if set, enter your 
password.

System ROM is bad; system is 
running in FailSafe Boot Block mode 
(indicated by 8 beeps).

Reflash the ROM using a SoftPaq.

Processor does not support 
graphics output and no discrete 
graphics card is installed

NOTE: Power LED flashes red 6 
times (once every second), followed 
by a 2-second pause, followed by 6 
beeps.

Either:

● Install a processor with graphics support.

● Install a supported MXM graphics card.

Computer is in Hibernate mode. Press the power button to resume from Hibernate mode.

Multiple displays are not enabled in 
the graphics control panel.

Go to the graphics control panel and enable multi-display by 
selecting either clone mode or extended mode.

The graphics driver is not loaded. Install the latest graphics driver.

The graphics driver is not working 
properly.

1. When you see Press F8 in the bottom-right corner of the 
screen, restart the computer and press F8 during startup.

2. Using the keyboard arrow keys, select Windows Safe 
Mode, and then press Enter.

3. In Windows, uninstall the graphics driver.

4. Reboot the computer into the normal Windows mode.

5. Install the latest graphics driver.

The display works 
properly during the POST 
but goes blank when the 
operating system starts.

The display settings in the 
operating system are incompatible 
with your graphics card and 
monitor.

1. For Windows, restart your computer in Windows Safe 
Mode.

2. After the operating system starts, change the display 
settings to match those supported by your graphics card 
and monitor.

3. See your operating system and graphics card 
documentation for information about changing display 
settings.

Multiple displays are not enabled in 
the graphics control panel.

Go to the graphics control panel and enable multi-display by 
selecting either clone mode or extended mode.

The graphics driver is not loaded. Install the latest graphics driver.
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Problem Cause Solution

Power LED flashes red 6 
times (once every 
second), followed by a 2-
second pause, followed 
by 6 beeps.

Prevideo graphics error. Try these solutions in this order:

● Reseat the graphics card if using nVidia graphics; reseat 
the processor if using Intel HD Graphics.

● Replace the graphics card if using nVidia graphics or 
replace the processor if using Intel HD graphics.

● Replace the system board.

Processor does not support 
graphics output and no discrete 
graphics card is installed.

Either:

● Install a processor with Intel HD Graphics.

● Install a supported graphics card.

Dim characters The brightness and contrast 
controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly connected. 1. Verify that the monitor cable is securely connected to the 
computer and the monitor.

2. Verify that internal Rear IO DP/LAN cable is connected to 
the system board and the Rear I/O board:

a. Open the computer.

b. Verify the Rear IO DP/LAN Cable is connected to 
CON6701 on the system board and J16 on the Rear 
I/O board (on the left bottom side).

Blurry video or requested 
resolution cannot be set.

If the graphics controller was 
upgraded, the correct video drivers 
might not be loaded.

Install the video drivers included in the upgrade kit, or 
download and install the latest drivers for your graphics card 
from http://welcome.hp.com/country/us/en/support.html.

Monitor cannot display requested 
resolution.

Change the resolution.

The picture is broken up, 
rolls, jitters, or flashes.

The monitor connections might be 
faulty, or the monitor might be 
incorrectly adjusted.

1. Verify that the monitor cable is securely connected to the 
computer and the monitor.

2. Verify that internal rear IO DP/LAN cable is connected to 
the system board and the rear I/O board:

a. Open the computer.

b. Verify the rear IO DP/LAN cable is connected to 
CON6701 on the system board and J16 on the rear 
I/O board (on the left bottom side).

Monitor must be degaussed. Degauss the monitor.

High pitched noise 
coming from inside a 
flat-panel monitor.

Brightness and contrast settings 
are too high.

Lower brightness and contrast settings.

Fuzzy focus; streaking, 
ghosting, or shadowing 
effects; horizontal 
scrolling lines; faint 
vertical bars; unable to 
center the picture on the 
screen (flat-panel 
monitors using an analog 
VGA input connection 
only.)

Flat-panel monitor’s internal digital 
conversion circuits might be unable 
to correctly interpret the output 
synchronization of the graphics 
card.

1. Select the monitor’s Auto-Adjustment option in the 
monitor’s onscreen display menu.

2. Manually synchronize the Clock and Clock Phase onscreen 
display functions.
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Problem Cause Solution

Some typed symbols do 
not appear correctly.

The font you are using does not 
support that symbol.

Use the Character Map to locate and select the appropriate 
symbol.

Select Start > All Programs > Accessories > System Tools > 
Character Map. You can copy the symbol from the Character 
Map into a document.

The graphics driver does is not 
working properly or does not 
support the symbol set with that 
resolution.

Try either solution:

● Change the panel resolution in the Windows Control 
Panel > Screen Resolution menu or through the control 
panel for the graphics controller (Intel or nVidia).

● Install the latest graphics driver:

1. Boot into the OS and uninstall the graphics driver.

2. Restart the computer.

3. Install the latest graphics driver for your graphics 
controller.

Solving audio problems

Problem Cause Solution

Sound does not come 
out of the speaker or 
headphones.

Software volume control is 
turned down.

Click the Speaker icon on the taskbar and use the volume slider to 
adjust the volume, and/or adjust the volume control in the audio 
player.

The external speakers are not 
turned on.

Turn on the external speakers.

External speakers plugged 
into the wrong audio jack.

See your sound card documentation for proper speaker connection.

Digital CD audio is 
not enabled.

Enable digital CD audio:

1. From the Control Panel, select Device Manager.

2. Right-click the DVD/CD-ROM device and select Properties.

3. On the Driver Properties tab, select Enable.

Headphones or devices 
connected to the line-out 
connector have muted the 
internal speaker.

Turn on and use headphones or external speakers, if connected, or 
disconnect headphones or external speakers.

Volume is muted. Click the Speaker icon on the taskbar and confirm that the mute 
button below the volume slider is not selected.

Computer is in Standby mode. Press the power button to resume from Standby mode.

Sound quality (such as 
tone, focus, space, 
equalization, treble or 
bass) from the internal 
speakers is not 
acceptable.

The graphic equalizer (EQ) 
and/or DTS audio 
enhancement settings have 
been changed and are not 
appropriate for the audio 
content being played.

1. Open the DTS user interface (found either in the Control Panel 
or the taskbar).

2. Go to the Advanced Settings tab.

3. Click the Reset button under Default Settings.

This restores the DTS audio enhancement settings, graphic 
equalizer, and volume to the default settings, which are optimized 
for most audio content.
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Problem Cause Solution

Sound occurs 
intermittently.

Processor resources are being 
used by other open 
applications.

Shut down all open processor-intensive applications.

Workstation appears to 
be locked up while 
recording audio.

The hard drive might be full. 1. Before recording, be sure there is enough free space on the 
hard drive.

2. Try recording the audio file in a compressed format.

The optical S/PDIF output 
does not work.

S/PDIF is not the default 
audio output device.

1. Go to Control Panel > Sound.

2. On the Playback tab, select Digital Output (S/PDIF).

3. Click Set Default.

Audio over DisplayPort is 
not working.

Either the monitor does not 
support audio, or DisplayPort 
is not the default audio 
output.

1. Go to Control Panel > Sound.

2. On the Playback tab, select the DisplayPort monitor. (If there is 
no monitor audio device listed, the monitor does not support 
audio).

3. Click Set Default.

Audio input does not 
work.

The wrong device is set as the 
default audio input.

1. Go to Control Panel > Sound.

2. On the Recording tab, select the appropriate input.

3. Click Set Default.

Solving printer problems

Problem Cause Solution

Printer does not print. Printer is not turned on and online. Turn the printer on and be sure it is online.

The correct printer driver for the 
application is not installed.

1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\> [printer port]

Replace printer port with the address of the printer used. 
If the printer works, reload the printer driver.

If you are on a network, you might 
not have made a connection to the 
printer.

Make the proper network connection to the printer.

Printer might have failed. Run printer self-test.

Printer does not turn on. The cables might not be connected 
properly.

 

Troubleshooting scenarios and solutions 61

Downloaded from www.Manualslib.com manuals search engine 

http://www.manualslib.com/


Using HP PC Hardware Diagnostics (UEFI)
HP PC Hardware Diagnostics is a Unified Extensible Firmware Interface (UEFI) that allows you to run diagnostic 
tests to determine whether the computer hardware is functioning properly. The tool runs outside of the 
operating system so that it can isolate hardware failures from issues that may be caused by the operating 
system or other software components.

To start HP PC Hardware Diagnostics UEFI:

1. Turn on or restart the computer, quickly press Esc, and then press F2.

The BIOS searches three places for the HP PC Hardware Diagnostics (UEFI) tools in the following order:

a. Connected USB drive

NOTE: To download the HP PC Hardware Diagnostics UEFI tool to a USB drive, see the following 
section.

b. Hard drive

c. BIOS

2. Click the type of diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostic test while it is running, press Esc.

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device
NOTE: The HP PC Hardware Diagnostics (UEFI) download instructions are provided in English only.

There are two options to download HP PC Hardware Diagnostics to a USB device:

Option 1: HP PC Diagnostics Homepage—Provides access to the latest UEFI version.

1. Go to http://hp.com/go/techcenter/pcdiags.

2. Click the UEFI Download link, and then select Run.

Option 2: Support and Drivers pages—Provides downloads for a specific product for earlier and later 
versions.

1. Go to http://www.hp.com.

2. Point to Support, located at the top of the page, and then click Download Drivers.

3. In the text box, enter the product name, and then click Go.

– or –

Click Find Now to let HP automatically detect your product.

4. Select your computer model, and then select your operating system.

5. In the Diagnostic section, click HP UEFI Support Environment.

– or –

Click Download, and then select Run.
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Diagnostic codes and errors
This section presents information about diagnostic LED codes, LED color definitions, and POST error 
messages to help you troubleshoot problems.

Diagnostic LED and audible (beep) codes

This section describes the front panel LED error and operation codes as well as the audible codes that might 
occur before or during the POST.

Activity Possible cause Recommended action

Power LED is blue. No 
beeps.

Computer on.

N/A

Power LED flashed blue 
every two seconds. No 
beeps.

Computer in Sleep mode 
(S3-Suspend to RAM). 
Select models only.

Power LED is off. No beeps. Computer in Hibernate 
mode (S4-Suspend to 
disk) or system is off (S5).

Power LED flashes blue 
three times*, once per 
second. No beeps.

Computer in Sleep mode 
(S3-Suspend to RAM). 
Select models only.

Power LED flashes blue four 
times*, once per second. No 
beeps.

Computer in Hibernate 
mode (S4-Suspend to 
disk).

*User-selectable. See Computer Setup (F10) Utility menu 
on page 15 for details.

For the following LED activity and beeps, the beeps are heard through the chassis speaker. Flashes and beeps repeat for five 
cycles. Then, only the flashes repeat.

Power LED flashes red two 
times, once every second, 
followed by a two-second 
pause. Two beeps.

CPU thermal protection 
activated by either of the 
following methods:

● A fan might be 
blocked or not 
turning.

● The heatsink and fan 
assembly is not 
properly attached to 
the CPU.

CAUTION: Internal components might be powered even when the 
computer is off. To prevent damage, disconnect the computer power 
cord before you remove a component.

1. Verify that the computer air vents are not blocked and the 
cooling fan is running.

2. Open the access panel, press power button, and verify that the 
CPU fan is spinning. If the CPU fan is not spinning, verify that the 
fan cable is plugged into the computer board header. Verify that 
the fan is fully and properly seated or installed.

3. If fan is plugged in and seated properly, but is not spinning, the 
problem might be in the CPU fan. Contact HP for assistance.

4. Verify that the fan assembly is properly attached. If problems 
persist, there might be a problem with the CPU heatsink. Contact 
HP for assistance.

Power LED flashes red three 
times, once every second, 
followed by a two-second 
pause. Three beeps.

CPU not installed (not an 
indicator of bad CPU).

CAUTION: Internal components might be powered even when the 
computer is off. To prevent damage, disconnect the computer power 
cord before you remove a component.

1. Verify that the CPU is present.

2. Reseat the CPU.
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Activity Possible cause Recommended action

Power LED flashes red four 
times, once every second, 
followed by a two-second 
pause. Four beeps.

Power failure (power 
supply is overloaded).

CAUTION: Internal components might be powered even when the 
computer is off. To prevent damage, disconnect the computer power 
cord before you remove a component.

1. Open the access panel and verify that all power connections are 
secure on the system board.

2. To verify if a device is causing the problem, remove all attached 
devices (such as hard drives, optical drives, and expansion 
cards.) Turn on the computer. If the system enters the POST, turn 
off the computer and replace one device at a time; repeat this 
procedure until failure occurs. Replace the device that is causing 
the failure. Continue adding devices one at a time to confirm that 
all devices are functioning properly.

Power LED flashes red five 
times, once every second, 
followed by a two-second 
pause. Five beeps.

Pre-video memory error. CAUTION: Internal components might be powered even when the 
computer is off. To prevent damage, disconnect the computer power 
cord before you remove a component.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate faulty module.

3. Replace third-party memory with HP memory.

4. The problem might be on the system board. Contact HP for 
assistance.

Power LED flashes red six 
times, once every second, 
followed by a two-second 
pause. Six beeps.

Pre-video graphics error. CAUTION: Internal components might be powered even when the 
computer is off. To prevent damage, disconnect the computer power 
cord before you remove a component.

Try these solutions in this order:

● Reseat the graphics card if using nVidia graphics; reseat the 
processor if using Intel HD Graphics.

● Replace the graphics card if using nVidia graphics or replace the 
processor if using Intel HD graphics.

● Replace the system board.

Processor does not 
support graphics output 
and no discrete graphics 
card is installed.

Either install a processor with Intel HD Graphics, or install a supported 
graphics card.

Power LED flashes red 
seven times, once every 
second, followed by a two- 
second pause. Seven beeps.

System board failure 
(ROM detected failure 
prior to video).

1. Clear CMOS.

NOTE: See Clearing and resetting the CMOS on page 73 for 
details.

2. The problem might be on the system board. Contact HP for 
assistance.

Power LED flashes red eight 
times, once every second, 
followed by a two-second 
pause. Eight beeps.

Invalid ROM based on bad 
checksum.

CAUTION: Internal components might be powered even when the 
computer is off. To prevent damage, disconnect the computer power 
cord before you remove a component.

1. Clear CMOS.

NOTE: See Clearing and resetting the CMOS on page 73 for 
details.

2. Upgrade the ROM using SoftPaq, either from the hard drive, CD, 
diskette, or USB flash drive (for example, HP Drive Key). The ROM 
can be flashed by through the F10 Setup Menu by going to 
File>Flash System ROM. SoftPaq is a self-extracting executable, 
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Activity Possible cause Recommended action

which contains instructions for its use, that enables you to 
upgrade the ROM. To download the Softpaq executable, go to 
http://www.hp.com/go/workstationsupport.

3. The problem might be on the system board. Contact HP for 
assistance.

Power LED flashes red nine 
times, once every second, 
followed by a two-second 
pause. Nine beeps.

System turns on but does 
not start.

1. The problem might be on the system board. Contact HP for 
assistance.

2. The problem might be in the CPU. Contact HP for assistance.

System does not power-on 
and LEDs are not blinking. 
No beeps.

System unable to turn on.

PSU doesn’t pass self test

CAUTION: Internal components might be powered even when the 
computer is off. To prevent damage, disconnect the computer power 
cord before you remove a component.

The user should perform the Built-In-Self-Test (BIST)

To resolve the problem, press and hold the power button for less than 
four seconds. Then, choose the appropriate option below.

If the hard drive LED turns green, try the following procedures in the 
sequence provided:

1. Remove the expansion cards one at a time and try holding the 
power button again for less than four seconds.

2. Contact HP for assistance. The problem might be on the system 
board.

– or –

If the hard drive LED does not turn green, try the following procedure:

1. Confirm that unit is plugged into a working AC outlet.

2. Open the access panel and confirm that the power button 
harness is properly connected to the system board.

3. Confirm that all power supply cables are properly connected to 
the system board.

* The BIOS option you select controls the blue LED function during these suspend modes.
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LED color definitions

The following table describes what each LED light on the computer front panel signifies.

LED state LED color System status

Solid Blue System is on.

Flashing Blue System is in Standby.

Solid or flashing Red
System has experienced an error. (See POST error messages 
on page 66.)

None No light System is in Hibernate mode, or is off.

POST error messages

The Power-On Self Test (POST) is a series of diagnostic tests that runs automatically when the computer is 
turned on.

Audible and visual messages occur before the operating system starts if the POST encounters a problem. 
POST verifies the following items to confirm that the computer system is functioning properly:

● Keyboard

● DIMMs

● CD or DVD drives

● All mass storage devices

● CPUs

● Controllers

● Fans

● Temperature sensors

● Cables (front/rear panels, audio, and USB ports)

The following table describes the POST error messages.

Screen message Probable cause Recommended action

101—Option ROM Checksum 
Error

System ROM checksum. Verify that you have the latest ROM:

1. Flash the ROM, if needed.

2. If an expansion card was recently added, 
remove it to find out if the problem remains.

3. Clear CMOS. If the message disappears, there 
might be a problem with the expansion card.

4. Replace the system board.

102—System Board Failure DMA, timers, and so forth, might be set 
improperly or might be defective.

1. Clear the CMOS.

2. Remove the expansion boards.

3. Replace the system board.
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Screen message Probable cause Recommended action

110—Out of memory space for 
option ROMs

Option ROM for a device could not run 
because of memory constraints.

Run the Computer Setup (F10) Utility to disable 
unneeded option ROMs, and to enable ACP1/USB 
Buffers at Top of Memory.

162—Systems Options Error RTC power (CMOS battery) is lost 1. Run Computer Setup (F10) Utility and set 
default settings.

2. Replace the CMOS battery.

3. Replace the system board.

163—Time and Date Not Set ● Invalid time or date in 
configuration memory.

● RTC battery might need 
replacement.

● CMOS jumper might not be 
properly installed.

1. Set the date and time from the Control Panel 
or in the Computer Setup (F10) Utility 
(depending on the operating system).

2. If the problem persists, replace the RTC 
battery.

164—Memory Size changed Memory configuration is incorrect. 1. Run the Computer Setup (F10) Utility or the 
Windows utilities.

2. Verify that the memory modules are installed 
properly.

3. If third-party memory has been added, test 
the memory configuration using HP memory.

4. Verify the memory module type.

201—Memory Error RAM failure. 1. Run the Computer Setup (F10) Utility or the 
Windows utilities.

2. Be sure that memory modules are installed 
correctly.

3. Verify the memory module type.

4. Remove and replace memory modules one at 
a time to isolate faulty modules.

5. Replace faulty memory modules.

6. If the error persists after replacing memory 
modules, replace the system board.

202—Memory Type Mismatch Memory modules do not match. Replace the memory modules with matched sets.

203—Memory module failed 
self-test and failing rank was 
disabled

Defective memory module. Replace the memory module.

204—Memory module failed and 
user rank was disabled

Improper module load. Reseat the memory module correctly.

205—Memory high temperature 
detected

Insufficient memory module cooling. Verify that a memory module cooling fan is installed 
and operating.

206—Memory setup invalid Memory configured incorrectly. Reconfigure the memory modules in the proper 
slots.

207—Incompatible DIMMs 
detected

DIMMs are installed that do not fulfill 
system requirements.

1. Verify that the memory module type matches 
computer requirements.

2. Insert the DIMM in the proper memory socket.

3. Replace the DIMM if the problem persists.
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Screen message Probable cause Recommended action

208—Mismatched DIMMs 
detected

Installed DIMMs are improperly 
matched.

Verify that matching DIMMs are installed.

209—Memory warning condition 
detected

Incorrect memory module type in use. Verify that the memory modules are compatible 
with computer requirements.

212—Failed Processor 0 Processor has failed to initialize. 1. Reseat the processor in its socket.

2. If the processor does not respond, replace it.

3. Replace the system board.

213—Incompatible Memory 
Modules

A memory module in the memory 
socket identified in the error message 
is missing critical SPD information, or 
is incompatible with the chipset.

1. Verify the memory module type.

2. Insert the DIMM in another memory socket.

3. Replace the module with a DIMM conforming 
to the SPD standard.

214—DIMM Configuration 
Warning

DIMMs are not installed correctly (not 
paired correctly).

See the service label on the computer access panel 
for the correct memory configurations, and reseat 
the DIMMs accordingly.

216—Memory Size Exceeds 
Maximum Supported

The amount of memory installed 
exceeds that supported by the 
hardware.

1. Verify how much memory the computer 
supports.

2. Remove the excess memory.

301—Keyboard Error Keyboard failure. 1. Reconnect the keyboard with the computer 
powered off.

2. Connect a keyboard directly to the computer 
(instead of through a switch box).

3. Be sure that none of the keys are pressed.

4. Replace the keyboard.

303—Keyboard Controller Error I/O board keyboard controller is 
defective or is not set properly.

1. Reconnect the keyboard with the computer 
powered  off.

2. Connect a keyboard directly to the computer 
(instead of through a switch box).

3. Replace the system board.

304—Keyboard or System Unit 
Error

Keyboard failure. 1. Reconnect the keyboard with the computer 
turned off.

2. Connect a keyboard directly to the computer 
(instead of through a switch box).

3. Be sure that none of the keys are pressed.

4. Replace keyboard.

5. Replace system board.

510—Splash Screen image 
corrupted

Splash Screen image has errors. Update system UEFI.

511—CPU Fan not detected Fan is not connected or is defective. 1. Reseat the fan cable.

2. Reseat the fan.

3. Replace the fan.

515—CPU Overtemp occurred Insufficient processor cooling or 
processor defect.

1. If necessary, add a heatsink to the processor 
and verify proper operation.
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Screen message Probable cause Recommended action

2. Replace the processor.

516—MXM fan not detected MXM fan missing, disconnected, or 
defective.

1. Reseat the fan cable.

2. Reseat the fan.

3. Replace the fan.

517—Memory fan not detected Memory fan missing, disconnected, or 
defective.

1. Reseat the fan cable.

2. Reseat the fan.

3. Replace the fan.

530—Left DMIC cable not 
connected.

Left Dmic cable is not connected to the 
system board or to the left Dmic.

1. Reseat the cable.

2. Replace the cable.

531—Right DMIC cable not 
connected.

Right Dmic cable is not connected to 
the system board or to the right Dmic.

1. Reseat the cable.

2. Replace the cable.

532—Side I/O board not 
connected.

Side I/O board is missing or is not 
connected.

1. Reseat the Side I/O board.

2. Replace the Side I/O board.

3. Replace the system board.

533—Rear I/O USB/Audio cable 
not connected.

The Rear I/O USB/Audio cable between 
the system board and Rear I/O board is 
missing or not connected.

1. Reseat the cable.

2. Replace the cable.

534—Rear I/O DP/LAN cable not 
connected.

The Rear I/O DP/LAN cable between the 
system board and Rear I/O board is 
missing or not connected.

1. Reseat the cable.

2. Replace the cable.

535—LED Backlight cable not 
connected.

The LED backlight cable between the 
system board and the LCD panel is 
missing or not connected.

1. Reseat the cable.

2. Replace the cable.

536—LCD DP cable not 
connected.

The LCD DP cable between the system 
board and the LCD panel is missing or 
not connected.

1. Reseat the cable.

2. Replace the cable.

539—Unable to read GPU 
temperature. The graphics card 
may overheat.

1. Power cycle the system.

2. If the problem persists, contact HP support.

550—Thunderbolt power cable 
not connected.

The Thunderbolt power cable is 
missing or not connected.

1. Reseat the cable.

2. Replace the cable.

551—Thunderbolt DP cable not 
connected.

The Thunderbolt DP cable is missing or 
not connected.

1. Reseat the cable.

2. Replace the cable.

552—Thunderbolt PCIE cable 
not connected.

The Thunderbolt PCIE cable is missing 
or not connected.

1. Reseat the cable.

2. Replace the cable.

538—Panel I/O cable not 
connected.

The Panel I/O cable is missing or not 
connected.

1. Reseat the cable.

2. Replace the cable.

912—Computer Cover Has Been 
Removed Since Last System 
Start Up

N/A No action required.
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Screen message Probable cause Recommended action

917—Front Audio cable not 
connected.

The Front Audio cable (speakers cable) 
is missing or not connected.

1. Reseat the cable.

2. Replace the cable.

922—Fatal error on PCIe slot X Fatal error occurred in the designated 
slot.

Move the card to a different slot. If the problem 
persists, replace the card.

925—Fatal Misc error A fatal miscellaneous chipset error was 
detected.

Contact HP Support.

928—Fatal machine check 
detected on CPU X

Contact HP support.

929—Fatal MCA error An MCA condition was detected on the 
system.

Contact HP Support.

942—Memory Training error A DIMM or DIMMs did not train correctly Contact HP Support.

1720—SMART Hard Drive 
Detects Imminent Failure

Hard drive is about to fail. (Some hard 
drives have a firmware patch that fixes 
erroneous error messages.)

1. Determine if the hard drive is giving a correct 
error message.

2. Run the UEFI F2 Diagnostics Drive Test (if 
applicable).

3. Apply firmware patch (if applicable). Go to 
 http://www.hp.com/support.

4. Back up contents and replace the hard drive.

1783—Fixed Disk 0/1 locked Hard drive failure. Diagnose the hard drive, and replace it if necessary.

1796—SATA Cabling Error Missing or improperly attached cable. Verify that a cable is attached. Reattach the cable.

1797—SATA Drivelock is not 
supported in RAID mode

SATA Drivelock is not supported in RAID 
mode.

Disable RAID mode, or disable SATA drivelock.

1801—Microcode Update Error Unknown or unsupported processor 
stepping.

The microcode update failed. Verify the processor 
stepping to confirm that it is a supported stepping. 
If it is contact, HP Support.

1802—Processor Not Supported The system board does not support 
the processor.

Replace the processor with a compatible one.

1803—Processor feature set is 
insufficient for current system 
settings

Processor feature set is insufficient for 
current system settings. The UEFI 
settings do not match the support 
provided by the processor

Change the UEFI settings or upgrade the processor.

1804—A processor feature and 
the memory configuration are 
incompatible

A processor feature is incompatible 
with the memory configuration.

Restore the previous memory configuration.

ERROR: Invalid electronic serial 
number (no number)

No electronic serial number is stored 
with the system

To assign a serial number, open Computer Select 
(F10) Utility, and then select Security > System IDs.

ERROR: An unsupported 
processor is installed. System 
halted

Unsupported processor detected. Replace the processor.

Invalid electronic serial number Incorrect serial number registered in 
the system.

To assign a serial number, open Computer Select 
(F10) Utility, and then select Security > System IDs.

Processor initialization fails Processor defective. Replace the processor.
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5 Configuring password security and 
resetting CMOS

This chapter describes how to configure password security and to reset CMOS, and includes these topics:

● Preparing to configure passwords on page 71

● Resetting the password jumper on page 71

● Clearing and resetting the CMOS on page 73

Preparing to configure passwords
The Computer Setup (F10) Utility enables you to create setup and power-on passwords.

There are three possibilities for setting passwords:

● Define a setup password only. You will need the password to enter Computer Setup (F10) Utility, but you 
will not need a password to start the workstation.

● Define a power-on password only. This password lets you start the workstation or enter the setup utility.

● Define both. In this case, the setup password lets you start the workstation and enter the setup utility. 
The power-on password starts the workstation but does not let you enter the setup utility,

After you create both passwords, you can use the setup password in place of the power-on password as an 
override to log in to the computer (a useful feature for a network administrator).

NOTE: You can only clear the passwords with the password jumper. Clearing CMOS does not clear the 
passwords.

CAUTION: Before pressing the Clear CMOS button, back up your computer CMOS settings.

Pressing the Clear CMOS button resets CMOS values to factory defaults and erases customized information, 
including asset numbers and special settings.

To back up the CMOS settings, run the Computer Setup (F10) Utility and select File>Replicated Setup>Save 
to Removable Storage Device.

Resetting the password jumper
Use the following procedure to disable the power-on or setup password features and clear the power-on and 
setup passwords.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to 
disconnect the power cord from the wall outlet and allow the internal system components to cool before 
touching them.

CAUTION: When the computer is plugged in, the power supply has voltage applied to the system board, 
even when the computer is turned off. Failure to disconnect the power cord can result in damage to the 
system.
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CAUTION: Static electricity can damage the electronic components of the computer or optional equipment. 
Before beginning these procedures, briefly touch a grounded metal object to be sure that you are discharged 
of static electricity.

1. Access the jumper:

a. Shut down the operating system, turn off the computer and external devices, and then disconnect 
the power cords from the computer and external devices.

b. Disconnect any external devices.

c. Open the workstation.

d. Locate the password header and jumper.

The password header is E49. The password jumper is blue so it can be easily identified.

2. Remove the jumper from pins 1 and 2. Do not lose the jumper.

3. Restart the computer:

a. Close the workstation.

b. Reconnect the AC power cord to the computer.

c. Turn on the computer and wait for the workstation to display the HP splash screen.

4. Repeat step 1.

5. Replace the jumper on pins 1 and 2.

6. Repeat step 3, except press the F10 key during startup to access Computer Setup (F10) Utility.

7. Use the setup utility to create new passwords.

NOTE: The BIOS option “Stringent Password” creates a password that cannot be reset by the password 
jumper.
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Clearing and resetting the CMOS
This section describes the steps necessary to successfully clear and reset the CMOS. The CMOS of the 
computer stores password information and information about the computer configuration.

Using the CMOS button to reset CMOS

To clear CMOS using the Clear CMOS button, use the following procedure:

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, disconnect the 
power cord from the wall outlet and allow the internal system components to cool before touching them.

CAUTION: When the computer is plugged in, the power supply has voltage applied to the system board, 
even when the computer is turned off. Failure to disconnect the power cord can result in damage to the 
system.

Static electricity can damage the electronic components of the computer or optional equipment. Before 
beginning these procedures, briefly touch a grounded metal object to be sure that you are discharged of static 
electricity.

1. Back up your computer CMOS settings with Computer Setup (F10) Utility, and select File>Replicated 
Setup>Save to Removable Storage Device.

CAUTION: Pressing the Clear CMOS button resets CMOS values to factory defaults and erases 
customized information, including asset numbers and special settings. 

2. Shut down the operating system, turn off the computer and external devices, and disconnect any 
external devices.

3. Disconnect the AC power cord from the computer and wait 30 seconds for the power to dissipate.

NOTE: The Clear CMOS button does not clear CMOS if the AC power cord is connected to the computer.

4. Open the workstation.

5. Locate and press the CMOS button.

For assistance locating the CMOS button and other system board components, see the system board 
layout in System board components on page 6.

6. Close the workstation, reconnect external devices, connect the power cord to the workstation, and then 
turn on the workstation.

7. The system boots to an F1 prompt and displays a message that the date/time has changed and that 
system options have changed.

8. Press F1. The system shuts down for three seconds and then restarts.

9. Use Computer Setup (F10) Utility to reset the date and time.
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Using Computer Setup (F10) Utility to reset CMOS

1. Access Computer Setup (F10) Utility menu.

2. When the computer setup message appears in the lower-right corner of the screen, press F10, and then 
press Enter to bypass the title screen, if necessary.

If you do not press F10 while the message is displayed, the computer must be rebooted to access this 
utility.

3. From Computer Setup (F10) Utility menu, select File, and then select Default Setup.

This restores the settings that include boot sequence order and other factory settings. However, it does 
not force hardware rediscovery.

4. Choose Restore Factory Settings as Default, and then press Enter to accept.

5. Select File > Apply Defaults and Exit, and then press Enter to accept.

6. Reset the computer passwords and configuration information, such as the system date and time.

NOTE: This step does not clear the passwords.
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A Linux technical notes

HP offers a variety of Linux solutions for HP workstation customers.

● HP certifies and supports Red Hat® Enterprise Linux (RHEL) on HP workstations.

● HP certifies SUSE Linux Enterprise Desktop (SLED) on HP workstations.

● HP offers a SLED 11 preload on some Z Series workstations.

For Linux setup and restore procedures, go to http://www.hp.com/support/workstation_manuals to find the 
user guide for your workstation.

Topics

System RAM on page 75

Audio on page 75

Network cards on page 76

Hyper-Threading Technology on page 76

NVIDIA Graphics Workstations on page 77

NOTE: After you set up the operating system, verify that the latest BIOS, drivers, and software updates are 
installed. 

CAUTION: Do not add optional hardware or third-party devices to the workstation until the operating 
system is successfully installed. Adding hardware might cause errors and prevent the operating system from 
installing correctly.

System RAM
HP supports different amounts of total RAM in various HP workstations, based on the number of hardware 
DIMM slots and the capabilities of the system. The total memory supported for each configuration is listed in 
the Hardware Support Matrix for HP Linux Workstations at http://www.hp.com/support/
linux_hardware_matrix.

Audio
All HP workstations come with built-in audio hardware. The audio hardware is supported by the Advanced 
Linux Sound Architecture (ALSA) drivers included with all modern Linux distributions.

The audio hardware provides basic playback and recording features. The ability to simultaneously play audio 
from multiple sources, such as applications and CDs, is provided by software mixing functionality in the ALSA 
driver. The performance of software audio mixing and playback functionality is greatly improved in ALSA 
drivers version 1.0.13 and later.

After the NVIDIA proprietary driver is installed, the optional NVIDIA graphics devices supported in the HP Z1 
G2 Workstation also provide audio functionality over HDMI, which can be passed through the external 
DisplayPort connector to a monitor with audio capabilities. Such a configuration may present two audio 
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hardware choices. If you do not hear sound through the speakers, one possible reason is that the NVIDIA audio 
device has been chosen by default. Verify the audio settings (for example, Sound in GNOME Control Center).

In some systems, embedded Intel HD graphics may also present a similar HDMI audio device that can be used 
through the DisplayPort interface. No proprietary driver is needed for this device, just a sufficiently recent 
kernel.

Network cards
All HP workstations include one or two integrated network interface controllers. The HP Z1 G2 Workstation 
includes a PCI Express Mini Card that implements both wireless LAN and Bluetooth. The iwlagn driver supports 
the wireless LAN; in most distributions, the Network Manager automatically senses that wireless networks 
are available. Bluetooth support is also available in many Linux distributions.

Hyper-Threading Technology
The Z Series workstations support Hyper-Threading Technology (HTT), an Intel-proprietary technology that 
improves processor performance through parallelization of computations (doing multiple tasks at once). The 
operating system treats an HTT-enabled processor as two virtual processors and shares the workload 
between them when possible. This feature requires that the operating system support multiple processors 
and be specifically optimized for HTT.

To enable HTT:

1. During startup, press F10 to enter Computer Setup (F10) Utility. Use the arrow keys to navigate and 
select options.

2. Select Advanced > Device Options.

3. Set Hyper-Threading to Enable, and then press F10 to exit the menu.

4. Select File > Save Changes and Exit.

5. Restart the system to enable HTT.

NOTE: On most recent Linux distributions, the kernel automatically detects that HTT is enabled and works 
correctly. 
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NVIDIA Graphics Workstations
Some HP Z1 G2 workstation configurations come with NVIDIA Quadro graphics hardware. HP recommends the 
use of NVIDIA proprietary graphics drivers for best results on Linux and Windows based systems. Go to the 
Support page on http://www.hp.com or http://www.nvidia.com for the latest available drivers.

HP also provides recommended versions of the drivers with RPM-compatible installers for RHEL and SLED 
distributions. These are available from the HP Installer Kit for Linux and from workstation driver repositories 
on hp.com. When HP installers are used, their contents and documentation links are installed in 
the /opt/hp/nvidia folder.

When installing Linux on an HP Z1 G2 workstation that contains an NVIDIA card, administrators should select 
a VESA-compatible driver to avoid the instability that is experienced with some open-source versions of the 
Nouveau and DRM drivers.

Open source versions of Nouveau drivers and NVIDIA proprietary graphics drivers cannot coexist in the same 
runtime environment because they use the same hardware resources. If administrators create their own Linux 
environments using NVIDIA proprietary graphics drivers but choose not to use versions packaged by HP, HP 
recommends that they manually append the following boot loader parameters to properly suppress the 
Nouveau driver at runtime (grub example below):

kernel /vmlinuz ... rdblacklist=nouveau nouveau.modeset=0
This action is applied by HP installers but must be applied/restored under other circumstances.

To customize the display characteristics and resolutions of an NVIDIA proprietary graphics driver 
environment, execute the following command:

/usr/bin/nvidia-settings
To create and manipulate the /etc/X11/xorg.conf file, execute the following command:

/usr/bin/nvidia-xconfig
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B Configuring RAID devices 

This appendix explains how to configure RAID arrays on your workstation.

Topics

RAID hard drive maximum and associated storage controller options on page 79

Supported RAID configurations on page 79

Configuring Intel SATA RAID on page 80

Configuring SATA RAID in Windows on page 81

Software RAID solution on page 81

For additional information about RAID configuration, go to http://www.hp.com/support/RAID_FAQs.
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RAID hard drive maximum and associated storage controller 
options

This section lists the maximum number of hard drives supported on HP workstations according to RAID 
configuration and storage controller options.

NOTE: This section applies to internal workstation configurations that do not use add-in cards and external 
enclosures.

● Max of 2 drives:

◦ 2 x 2.5” (SFF HDD or SSD)

OR

◦ One 3.5” HDD (Using 3.5” HDD Carrier) plus one mSATA drive

● Max of 3 drives:

◦ 2 x 2.5” SFF HDD or SSD (Using 2.5” HDD carrier) plus one mSATA drive

Supported RAID configurations
The following RAID configurations are supported:

RAID configuration details

Configuration Description Controllers

RAID 0

Integrated striped disk 
array

● Requires a minimum of two drives.

● Provides improved I/O performance.

● Provides no fault tolerance.

● Loses all data if any disk in the array fails.

● Increases disk performance.

Intel with RST

RAID 1

Mirrored disk array

● Supports a minimum of two drives.

● Provides 100% redundancy: all data from one drive 
is duplicated on a second drive.

● Recovers from a single-drive failure.

● Serves as a good entry-level redundant system.

Intel with RST
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Configuring Intel SATA RAID 
This section describes how to use Intel® Rapid Storage Technology (RST) to set up and manage SATA RAID 
volumes.

NOTE: These instructions apply to Windows-based systems.

You can create a SATA RAID array that contains up to the maximum number of internal SATA hard drives and 
eSATA drives (if you use an optional eSATA bulkhead cable) supported on your workstation.

The Intel SATA option ROM configuration utilities run when you select RAID for the SATA emulation mode.

Two or more hard drives must be attached to the controller for the option ROM to run.

Configuring the system BIOS to enable embedded SATA RAID functionality

The Z1 G2 Workstation defaults to RAID emulation mode. RAID emulation mode includes the benefits of AHCI 
with the added benefit of supporting RAID configurations. If the mode has been changed to IDE or AHCI, follow 
the steps below to change it back.

CAUTION: Changing SATA emulation modes after the OS has been installed will prevent the system from 
booting and require reinstallation of the OS. Back up your data before changing SATA emulation mode.

1. During startup, press F10 to enter Computer Setup (F10) Utility. Use the arrow keys to navigate and 
select options.

2. Select Storage > Storage Options, then press Enter.

3. Select SATA Emulation.

4. If not already set to RAID, use right/left arrow keys to select RAID

a. Read the warning and press Enter to dismiss the warning. If your OS was installed in a SATA 
emulation mode other than RAID, you will need to reinstall your OS.

b. Press F10 to accept the settings.

5. Navigate to Security > Secure Boot Configuration.

6. Verify that Legacy Support is set to Enabled. If not enabled, use the arrow keys to change Legacy 
Support to Enabled.

a. Read the Legacy Support message and press Enter to dismiss the message.

b. Press F10 to accept the settings.

7. Navigate to Advanced > Option ROM Launch Policy > Storage Option ROMs.

● Verify that Storage Option ROMs are set to Legacy Only. If not set to Legacy Only use the arrow 
keys to change to Legacy Only.

● Press F10 to accept the settings.

8. Navigate to Save Changes and Exit and press Enter.

Hint: Pressing F10 several times will also take you back to the File menu. Yes should already be selected 
in the Save Changes and Exit. Press Enter to confirm.

9. The system will reboot.
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Configuring RAID volumes in Option ROM

Follow these steps to create RAID volumes.

1. Press ctrl+I, when prompted, to enter the Intel Rapid Storage Technology Option ROM. Use the arrow 
keys to navigate and select options.

NOTE: If only a single hard drive is attached, the utility does not execute. No message is displayed.

2. Select 1. Create RAID Volume,and then press Enter.

3. Enter the desired RAID volume name in the name field, and then press Tab.

4. Select a level in the RAID Level field by using Up and Down arrows, and then press Tab.

5. If appropriate, press Enter to select disks. Use Up and Down arrows to highlight the disks, and Space to 
select each disk and press Enter when done.

6. If appropriate use Up and Down arrows to select a size in the Strip Size field, and then press Tab.

7. Enter the desired size in the Capacity field, and then press Tab

8. Press Enter to initiate volume creation.

Configuring SATA RAID in Windows
This section explains how to use the Intel Rapid Storage Technology Utility to set up and manage SATA RAID 
volumes in Windows.

1. Press the Windows key and start typing Intel. “Intel ®Rapid Storage Technology should appear in 
Programs. Click on Intel Rapid Storage Technology to start the Graphical User Interface (GUI). 
Alternatively, in Windows 7, you can click the Start button at the lower left corner of the screen and 
navigate to the Intel Rapid Storage Technology.

2. Click Yes if prompted, to allow the application to make changes to your system.

3. Click the Create button at the top of the window.

4. Select the desired volume type and click the Next button. (Only valid configurations will be available. All 
other options will be grayed out and not selectable.)

5. A default name will be shown. You can change the name to something more descriptive if desired.

6. Click on the checkbox to select each disk that you want included in the RAID volume.

7. Adjust the volume size if desired.

8. Click Next.

9. Review the proposed configuration and click Create Volume.

10. You will receive a “Volume Creation Complete” message. Click OK to dismiss the message.

11. Close the Intel ®Rapid Storage Technology GUI.

12. Remember to open the Disk Management snap-in to initialize and format the newly created array. The 
new array will not be visible until it is initialized and formatted.

Software RAID solution
This section summarizes software RAID considerations that are specific to the Linux environment, and 
provides links to additional configuration resources.
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Software RAID considerations

The Linux kernel software RAID driver (called md, for multiple device) offers integrated software RAID without 
the need for additional hardware disk controllers or kernel patches. Unlike most hardware RAID solutions, 
software RAID can be used with all types of disk technologies, including SATA, SCSI, and solid-state drives. 
This software solution requires only minimal setup of the disks themselves.

However, when compared to hardware-based RAID, software RAID has disadvantages in managing the disks, 
breaking up data as necessary, and managing parity data. The CPU must assume some extra loading: disk-
intensive workloads result in roughly double the CPU overhead (for example, from 15% to 30%). For most 
applications, this overhead is easily handled by excess headroom in the processors. But for some applications 
where disk and CPU performance are very well balanced and already near bottleneck levels, this additional 
CPU overhead can become troublesome.

Hardware RAID offers advantages because of its large hardware cache and the capability for better 
scheduling of operations in parallel. However, software RAID offers more flexibility for disk and disk controller 
setup. Additionally, hardware RAID requires that a failed RAID controller must be replaced with an identical 
model to avoid data loss, whereas software RAID imposes no such requirements.

Some software RAID schemes offer data protection through mirroring (copying the data to multiple disks in 
case one disk fails) or parity data (checksums that allow error detection and limited rebuilding of data in case 
of a failure). For all software RAID solutions on HP workstations, redundancy can be restored only after the 
system is shut down so that the failed drive can be replaced. This replacement requires only a minimum 
amount of work.

Performance considerations

Disk I/O bandwidth is typically limited by the system bus speeds, the disk controller, and the disks 
themselves. The balance of these hardware limitations, as affected by the software configuration, determines 
the location of the any bottleneck is in the system.

Several RAID levels offer improved performance relative to stand-alone disk performance. If disk throughput 
is restricted because of a single disk controller, RAID can probably do little to improve performance until 
another controller is added. Conversely, if raw disk performance is the bottleneck, a tuned software RAID 
solution can dramatically improve the throughput. The slower disk performance is, relative to the rest of the 
system, the better RAID performance will scale, because the slowest piece of the performance pipeline is 
being directly addressed by moving to RAID.

Configuring software RAID

See the following sites for additional information about configuring software RAID on Red Hat Enterprise 
Linux (RHEL) or SUSE Linux Enterprise Desktop (SLED):

● Red Hat Enterprise Linux 6—See the Storage Administration Guide at https://access.redhat.com/site/
documentation

● SLED 11—See the Deployment Guide at http://www.suse.com/documentation/sled11/
book_sle_deployment/?page=/documentation/sled11/book_sle_deployment/data/
book_sle_deployment.html.

For more information about Open Source and Linux at HP, go to http://www.hp.com/go/opensource.
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C System board designators

This appendix describes the system board designators for this computer.

Main system board

Designator Name on board Component

E1 FDO Flash Descriptor Override header/jumper

E14 BB Boot Block header/jumper

E15 BBR Crisis recovery header/jumper

E49 PSWD Clear password header/jumper

P66 WEBCAM Webcam/Digital Mic connector

CON6701 DP/LAN Rear DP/LAN connector (white)

J7 J7 Side I/O connector (black)

J17 Rear IO Rear USB connector (white)

J18 Rear Audio Rear audio connector (white)

J65 eDP eDP (embedded DisplayPort) connector (white)

J41 MXM MXM (PCIe x16) graphics connector (black)

J31 mPCIe/mSATA1

SLOT1

Mini-PCIe/mSATA connector (black)

J32 mPCIe/mSATA2

SLOT2

Mini-PCIe/mSATA connector (black)

J12 TBT_PCIE Thunderbolt 2 module PCIex4 connector (black)

J11 TBT_DP Thunderbolt 2 module DP connector (black)

J8 TBT PWR Thunderbolt 2 module power connector (white)

SW50 CMOS Clear CMOS button

P1 PWR Power Supply, 20-pin (white)

P2 PWR LED LED Sync and Power, 19-pin (black)

P5 PB/LED Side power button/LED (black)

P10 MXM FAN MXM blower (white)

P9 MEM FAN Memory blower (black)

P24 TOUCH USB Touch USB 2x5 header (blue)

P60 SATA0 SATA 6.0 Gbps hard drive port (black)

P61 SATA1 SATA 6.0 Gbps hard drive port (black)
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Designator Name on board Component

P62 SATA2 SATA 6.0 Gbps optical drive port (black)

P8 CPU FAN CPU cooler (black)

P125 HSENSE Hood sensor (white)

P160 SATA PWR SATA hard drive power (white)

P161 ODD PWR SATA optical drive power/eject (white)

P6 SPKR Internal speakers (white)

XBT1 BATT Battery holder

BZ1 BZ1 Internal buzzer for beep codes (black)

XMM1 - XMM4 DIMM1 — DIMM4 Memory slots

XU1 PROCESSOR CPU socket

Rear I/O board
All connectors on the rear I/O board, except for J90, are on the bottom of board.

Designator Name on board Component

J90 USB2 Internal USB 2.0 Type A

J9 RJ45 LAN

J64 DISPLAYPORT DisplayPort

J15 Rear IO Rear USB/Audio connector (white)

J16 DP/LAN Rear DP/LAN connector (white)

J81 USB2 Dual-USB 2.0

J82 USB2 Dual-USB 2.0

J76 S/PDIF Optical S/PDIF

J79 SUB Subwoofer jack

J73 IN Audio line-in jack

J74 OUT Audio line-out jack
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Side I/O board

Designator Name on board Component

J72 MIC Microphone jack

J75 HDSET Headset jack

J71 USB3 USB 3.0 & battery charging port

J70 USB3 USB 3.0

J166 CARD READER SD 4.0 card reader

J7 J7 Side I/O connector (bottom side)

Thunderbolt 2 module board

Designator Name on board Component

J8 TBT-PWR Thunderbolt 2 module power connector (black)

J11 TBT_DP Thunderbolt 2 module DP connector (black)

J12 TBT_PCIE Thunderbolt 2 module PCIe connector (black)

CON1 TBT1 Thunderbolt 2 module port 1 (top port in system)

CON2 TBT2 Thunderbolt 2 module port 2 (bottom port in system)
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